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Micro Focus Enterprise Developer 3.0 for
Visual Studio Release Notes

These release notes contain information that might not appear in the Help. Read them in their entirety
before you install the product.

Note:

• This document contains a number of links to external Web sites. Micro Focus cannot be
responsible for the contents of the Web site or for the contents of any site to which it might link.
Web sites by their nature can change very rapidly and although we try to keep our links up-to-date,
we cannot guarantee that they will always work as expected.

• Check the Product Documentation section of the Micro Focus SupportLine Web site and the Micro
Focus Infocenter for any updates to the documentation which might have been uploaded.

Product Overview

Enterprise Developer supports IBM COBOL, IBM PL/I, IBM Assembler, IBM CICS, IBM IMS, IBM JCL, IBM
DB2, IBM z/OS file formats and common batch utilities, including SORT. This means that you can develop
and maintain the core mainframe online and batch applications under Enterprise Developer. You can then
deploy these applications back on the mainframe or migrate them onto one of the Micro Focus Linux, UNIX
or Windows-based production platforms.

Upgrading from earlier Micro Focus products

Application executables that were compiled using earlier Micro Focus products must be recompiled from
the sources using Enterprise Developer. For more information, read the section Upgrading to Enterprise
Developer in the product Help.
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What's New
This release provides enhancements in the following areas:

• Integration with Visual Studio
• Application Server JCA support for Enterprise Server
• Azure support
• Building applications
• CICS Web services
• COBOL language enhancements
• Code analysis
• Code coverage
• Compiler control
• Data File Tools
• Database access - HCO for DB2 LUW
• Database access - HCOSS
• Database access - MySQL
• Database access - OpenESQL
• Debugging applications
• Documentation
• Enterprise COBOL 6.1 compatibility
• Enterprise Server
• Enterprise Server for .NET
• Interface Mapping Toolkit
• iFileshare
• IMS support
• Mainframe Access (MFA)
• Micro Focus Unit Testing Framework
• PL/I support
• Rumba terminal emulator
• XML processing

Integration with Visual Studio

This release provides enhancements in the following areas:

• Integration with Microsoft's Visual Studio 2017, the most recent version of world’s most popular
integrated development environment (IDE) for the Windows platform, offering significant benefits for
developers and businesses developing software for Windows.

• COBOL Editor:

• Brace completion - a closing quote mark or bracket is automatically inserted when you type the
opening quote mark or bracket at the end of a line.

• Brace matching for IF and EVALUATE statements - clicking on any of the clauses of these
statements highlights the opening and closing statements and all clauses. Use CTRL + ] to move the
cursor to the next clause in the statement.

• Collapse to definitions - closes all sections, entry points and methods in an open file. Use the
Outlining > Collapse to Definitions editor context menu command.

• Colorization is now available for QuickInfo, completion tooltips and signature help.
• Completion of statements - IF and EVALUATE statements are now automatically aligned and

completed.
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• Indentation - smart indentation is now available to control how lines indent within IF and PERFORM
statements and after continuation statements.

• Locate definition, , on the COBOL toolbar enables you to search for data items and identifiers by
specifying any string of characters that might be part of their name. This command replaces Edit >
Go To Location.

• Outlining - outlining is now available for 01 level for group items (for expanding and collapsing the
entire group) and for EXEC blocks

• Quick actions (a feature of Visual Studio versions 2015 and later) - Enterprise Developer now
supports Visual Studio's quick actions for setting the CICSECM Compiler directive, rename
refactoring, and finding or creating missing copybooks.

• Tooltips are now available for managed COBOL members.
• COBOL toolbar - the commands on the COBOL toolbar have been updated in order to optimize your

editing experience. A number of commands (renumber and unnumber) have been removed from the
context menu in the editor and are now only available from the toolbar.

• Directives determination - there is now a preview dialog box when the IDE scans your sources for
Compiler directives. This enables you to review and approve the directives before they are set.

• Error reporting - you can now sort the errors and warnings Error List window by their COBOL error
code.

• Import, export and synchronization of the IDE options - you can now export a number of the COBOL
and PL/I global options as a Visual Studio .settings file. You can import the file into other instances of
Enterprise Developer.

Enterprise Developer for Visual Studio 2015 and later now supports the automatic synchronization of a
number of COBOL settings across the copies of Visual Studio installed on different machines. The
settings are synchronized through your MSDN account. See the MSDN for more details and for
information on any restrictions to the functionality.

• Project Details window - provides a number of enhancements, including performance improvement. It
is now possible to filter on project or solution, perform a search, and sync with Solution Explorer.
Tooltips are available in the Overrides column to show the override directives.

• Net Express import wizard - provides a new option for including copybooks in a project.
• Rename refactoring - this release introduces rename refactoring for COBOL code that can help to

improve the readability of COBOL elements or make their purpose clearer. You can rename elements
such as variables and identifiers, section and paragraph names, classes, and methods across a
program or a solution.

• Support for standalone files - various improvements have been made to how you work with files that are
not part of a project:

• When you first open a standalone file, the editor displays an alert bar with options to browse for a
symbols (.idy) file to use to compile the standalone file or to configure the Compiler directives.

• You can now use the file's properties window to edit the Compiler directives and to specify options
for debugging.

In previous versions of Enterprise Developer, standalone files were known as "single files". References
to "single files" in the IDE and the product help have been changed to "standalone files".

Back to Top

Application Server JCA support for Enterprise Server

In this release, EJBGEN has been updated to generate an EAR file as a part of the COBOL deployment
process, which enables you to deploy EJBs to Java Application Server.

Back to Top

Azure support

Enterprise Developer now supports the following versions of Microsoft Azure SDK - version 2.9.6 with
Visual Studio 2013 and version 3.0 with Visual Studio 2015 and later.
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Back to Top

Building applications

This release provides the following improvements:

• Support for faster, parallel building on multi-CPU machines - support has been added for multi-
processor compilation of the sources in native COBOL projects on multi-CPU machines.

You can specify the maximum number of concurrent compilations from the IDE preferences - Tools >
Options > Micro Focus > Projects. In Visual Studio, multi-processor compilation must also be enabled
in the project's properties.

Back to Top

CICS Web Services

In this release, CICS Web services support includes the following additional features:

• CICS JSON Web services for request/response and RESTful JSON. CICS Web Services support has
been extended to allow JSON/REST requests to be used in both requestor and provider mode.

• Use of container-based mappings

Back to Top

COBOL language enhancements

This release includes the following enhancements to the COBOL syntax:

• The DISPLAY-OF and NATIONAL-OF intrinsic functions are now able to process conversions using any
IBM CCSID value.

The following enhancements are available in managed COBOL:

• To avoid an exception being thrown if an explicit conversion fails, use the AS IF syntax, which results in
the target object being set to null and no exception thrown.

Back to Top

Code analysis

This release provides the following improvements:

• A new group of predefined rule sets for 64-bit readiness is now included in Enterprise Developer.
• Support for importing code analysis reports produced with one of Micro Focus's advanced tools for code

analysis, Enterprise Analyzer or COBOL Analyzer.

Back to Top

Code coverage

The following improvements are available within the IDE:

• Information about unexecuted programs - the code coverage reports in the Code Coverage window
now show the unexecuted programs.

• Code coverage support for standalone COBOL files - you can import existing code coverage reports in
the Code Coverage window and use it to supply code coverage information for standalone files.

If you are using Test Coverage from the command line, you can now use the following features:

• A new Compiler directive, COLLECTION - the directive enables test coverage to gather information
about unexecuted programs. In the IDE, this directive is automatically set on a project when you enable
code coverage for it.
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• A new command line utility, tcutil - the utility enables you to convert the test coverage binary results file
into XML format.

• It is now possible to integrate test coverage in a Continuous Integration (CI) system. You can use tcutil
and an XSLT processor to transform test coverage data into a format suitable for including in a CI.

Back to Top

Compiler control

The following Compiler directives are new in this release:

• COLLECTION - provides a mechanism for code coverage to identify unexecuted programs.
• ILSTDLIB - helps you to ensure that your .NET COBOL code compiles with the correct version of

the .NET Framework Microsoft Common Object assembly mscorlib.dll. When building from Visual
Studio or using MSBuild to compile a COBOL project, the NOILSTDLIB directive is set, and an ILREF is
generated pointing at the version of mscorlib appropriate for the target framework selected in the
project's properties.

The following Compiler directives have been updated:

• ALIGN - this directive has new parameters (FIXED and OPT) that can be used in conjunction with the
integer taken, which can aid performance. The default is ALIGN"8 OPT"; see the Comments section of
the ALIGN Compiler directive topic for details of its affect on memory boundaries.

• ARITH - this directive emulates the IBM mainframe option of the same name. Defines the maximum
number of digits for numeric data items.

• FASTINIT - this directive is now on by default when setting the MF dialect; it remains not set by default
for other dialects.

• SSRANGE - this directive now has an additional option (3), which permits zero-length reference
modified items at run time when bounds checking.

• XMLPARSE - includes a change in the way entities are processed when XMLPARSE(COMPAT) is set

Back to Top

Data File Tools

This release provides the following enhancements to Data File Tools:

• Opening files in shared mode - it is now possible to switch between read-only shared and edit modes.
While a file is open in shared mode, others users can only open it in shared mode to ensure data
consistency between users.

• Enterprise Server-level of security when accessing files - there is an improved level of security when
exchanging data between Data File Tools and the targeted enterprise server instance. Users must now
provide a user ID, group and a password when they try to access and view datasets in enterprise server
instances. These are used for authentication and authorization checks to provide the same access level
as Enterprise Server.

• Opening datasets using SSL - communication to a region is now possible using SSL. To enable the SSL
communication, you need to provide a Java trust store which contains either a CA root certificate or a
self-signed certificate of the region that it is communicating to. Java and the targeted region SSL
configurations need to meet each other's standards in order for the communication to succeed.

This feature enables you to secure the information exchange between Data File Tools and the targeted
enterprise server.

• Auditing of access and updates on datasets - Audit Manager now audits the access and updates on
datasets via Data File Tools.

• Support for existing .pro files - enables you to use your existing editor profiles.
• Support for existing .str files - enables you to use your existing COBOL and PL/I structure files.
• Automatic timeout - if no internal operations or external actions (such as a mouse click) have been

detected for 30 minutes, Data File Tools now displays a countdown message. If the user does not take
any decision within the specified period, Data File Tools closes all opened files.
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Back to Top

Database access - HCO for DB2 LUW

This release provides a new DB2(QUALIFY-CALL) Compiler directive that enables stored procedure
invocations to include a schema name.

Back to Top

Database access - HCOSS

This release provides a new Offline Schema Extract feature – a batch solution that migrates a z/OS DB2
catalog to SQL Server without direct access to z/OS DB2.

Back to Top

Database access - MySQL

This release provides support for MySQL with ODBC.

Back to Top

Database access - OpenESQL

This release provides the following new features:

• Statement prefixes for the SQL(CHECK) Compiler directive that enable the creation of temporary tables
and other SQL objects at compile time, ensuring full SQL syntax checking during compilation.

• SQL(OPTIMIZECURSORS) Compiler directive that enhances processing for traditional embedded SQL
cursors that use WITH HOLD and FOR UPDATE clauses.

• SQL(CLOSE_ON_COMMIT) Compiler directive to leave cursors open for further result set processing
after a commit.

• SQL(GEN-SQLCA) Compiler directive that generates an SQLCA similar to the z/OS DB2 directive
STDSQL(YES).

Back to Top

Debugging applications

This release provides the following new features:

• A new drop-down option, Any on the Debug tab in the project's properties of native Mainframe
Subsystem application projects, enables you to debug without specifying the type of application.

Back to Top

Documentation

The following new sections have been added to the product help:

• Where do I start? - located on the launch page of the product help, this section provides the information
you need in order to get started depending on which aspects of the product you need to get to grips
with first.

• Configuring an SSL Client Connection to a Mainframe - includes instructions about how to configure
client applications to connect to MFA and z/Server mainframe via AT-TLS in a zOS environment.

Back to Top

Enterprise COBOL 6.1 compatibility

The following features have been added to support Enterprise COBOL 6.1:
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• A new statement, JSON GENERATE, which enables you to convert data to JSON format.
• A new special register, JSON-CODE, and its resulting exception codes to support the new statement.
• Two further new statements, ALLOCATE and FREE, to obtain and release dynamic storage.
• A new MF level, MFLEVEL"19", which contains the following new additions to the reserved words list:

• JSON
• END-JSON
• ALLOCATE
• FREE
• INITIALIZED (context-sensitive reserved word)

Note: These keywords are also in effect under the ENT dialect.

• The SSRANGE Compiler directive has an additional option (3), which permits zero-length reference
modified items at run time when bounds checking.

• Support for the INITIALIZE statement under the ENT dialect has been enhanced.

Back to Top

For more information see Related Information at the end of this topic.

Enterprise Server

Improvements are available in the following areas:

Integration with Visual Studio:

• Exporting an enterprise server definition from the IDE in XML format.
• Importing an enterprise server into the IDE using its definition file.
• In Visual Studio, it is now possible to configure an enterprise server to produce a core dump file directly

from the IDE, from the server properties.

EXEC CICS TRANSFORM:

• Enterprise Server now supports the XMLTODATA and DATATOXML options of this API.

JCL spool

The JCL spool repository infrastructure has been redesigned to significantly improve its performance. The
improvements include:

• A more disk-efficient infrastructure, reducing the space required by the spool files by up to 75% in some
cases.

• Improved internal indexing, resulting in quicker generation of messages and sysout records during
processing.

• Improved navigation of spool queues: job status Complete replaces the Output, Out Hold, and
Printed statuses, and completed jobs with any combination of sysout files can be displayed in a single
list.

• Increased range of job numbers, from five digits to seven digits.

Important: These changes are automatically in place for new enterprise servers that you create.
To enable these updates to existing enterprise servers, you must run a conversion utility before
any JCL processing is permitted. Follow the To run the spool conversion utility process,
detailed in Significant Changes in Behavior, for each existing JES-enabled enterprise server you
have.

Long user IDs and passwords:

• Enterprise Server now supports user IDs and passwords of up to 100 characters. It is possible to map
IDs from long to short (or vice versa) to enable compatibility with programs that do not support long
names.
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Multi-factor sign-on:

• Multi-factor authentication enables users to sign on to Enterprise Server CICS without entering a
username and password. A secure user identifier, such as a certificate, is mapped to a username and is
used to generate a passtoken. It is possible to use smartcards, biometrics, or other authentication
systems to identify yourself to the system. The username and passtoken can then be used to log on to
CICS in an automated way.

The supported sign-on mechanisms are Express Logon Feature (ELF) and Automated Sign-On for
Mainframe (ASM). See the product Help for examples of how to configure a region to use the two
mechanisms.

SHA-256 support in DemoCA:

• By default, the Demonstration Certificate Authority (CA) now signs certificates with SHA-256. This
ensures that the demonstration or evaluation certificates will be accepted by modern browsers and
other software that has enhanced security requirements.

Syslog auditing:

• Enterprise Server now supports auditing using syslog events, which can be consumed by a wide range
of Security Information and Event Management (SIEM) products. This replaces the Audit Manager
auditing solution. Syslog auditing provides a much more efficient auditing mechanism, with significantly
less impact on overall speed.

Back to Top

Enterprise Server for .NET

This release provides enhancements in the following areas:

• Public class library - offers enhanced functionality for applications to interact with a running JES system:

• Dynamic dataset allocation/deallocation
• KSDS/ESDS/RRDS file handling support
• ENQ/DEQ support

• Web User Interface (Technology Preview) - this is a Technology Preview of a web-based UI for the
administration of an Enterprise Server for .NET system. The UI enables you to administer an Enterprise
Server for .NET system from any device supporting a web browser and without the need to install
Enterprise Server for .NET. The following features are available:

• Starting and stopping of regions
• The following views - Console, Statistics, Local trace tables, Monitor, Dynamic listener control and

the HSF view for CICS.
• Region-specific external file handler (EXTFH) configuration - it is now possible to specify EXTFH

configuration on a per-region basis using the MMC UI region start-up file editor. Previously, you had to
specify EXTFH configuration on a per-machine basis and it was global to all regions. This could have
lead to inconsistency in application behavior if one or more machines in a scale-out had different
configurations defined.

• HSF performance improvements - various improvements have been made to HSF to reduce the amount
of database processing required. This lowers the impact on application performance when HSF is
enabled for a region.

• Accepting input from the system console - system console input can now be provided from the MMC UI
console view, or using the seesys command-line utility. The input is provided to JES applications using
ACCEPT FROM CONSOLE and to CICS applications using EXEC CICS WRITE OPERATOR REPLY.

• JES seven-digit job numbers - you can now configure JES regions to allow up to seven-digit job
numbers to be used. This enhancement is also available in the native Enterprise Server product.

The following new features were initially provided as HotFix updates of Enterprise Server for .NET 2.3
Update 2 and are now available in this release:

What's New | 11



• Dataset name filtering by the MMC UI Catalog view - it is now possible to filter catalog name entries
through the use of wildcards in the MMC UI Catalog view. This helps reduce the time to display dataset
names when a catalog contains a great number of entries.

• MMC UI file viewer enhancements:

• Options for closing all open files, closing all but the currently selected file, and for loading all of the
remaining lines of a file.

• Viewing the contents of SYSOUT files being written by active job steps.
• Improved task recovery - Enterprise Server for .NET now automatically detects when a SEP pool

process dies (for example, when you stop debugging, or the machine shuts down), or is no longer
responsive, and recovers any running CICS transactions or JES jobs. This provides improved system
integrity by ensuring that the responsiveness and work through a running system is maintained
following a SEP pool failure.

Back to Top

Interface Mapping Toolkit

The Interface Mapping Toolkit (IMTK) contains the following enhancements in this release:

• Cross Origin Resource Sharing (CORS) support for REST Web services, enabling Web service access
from a CORS-supported Web browser.

Back to Top

iFileshare

iFileshare is no longer considered an Early Adopter Program, and contains the following enhancements in
this release:

• An improved failover and recovery process. iFileshare now supports full recovery of nodes in the group.
For high availability (HA-VSAM) groups, servers can now rejoin the group without the entire group
having to be restarted. In addition:

• A primary failover now results in a takeover from the most suitable node.
• If configured, external clients will automatically reconnect to the new primary and will issue a

notification if the transaction has been lost.
• A failed node, when restarted, will rejoin the group, recover its files and request a log update from

the current primary. Once this task has completed it will be considered an active hot-standby and will
continue to process replication requests as normal.

• Users will experience a higher level of uptime/availability with their Fileshare configuration and will be
able to recover from errors more easily.

• A new exit procedure, ifsexitproc.cbl, can be configured to automate some aspects of iFileshare
behavior.

• The iFileshare Control page in ESMAC contains details of the current iFileshare high availability group.
• The following new iFileshare-specific environment variables are available:

• FSWRKDIR - enables you to specify the Fileshare working directory, overriding the default, which is
the system directory of the region.

• FSCHKLFH - determines if a check is performed when a high availability group is started, to test the
consistency of the data files within the group.

• The database reference file (dbase.ref) now supports wildcard matching for filenames, allowing you
to perform operations on multiple files at once; for example: fs /d dbase.ref /f data\* adds the
entire contents of the data directory to the database reference file.

Back to Top
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IMS support

A new MFSGEN Compiler directive, CONTMVS, has been added to enable the compiler to parse MFS
continuation lines (those continued without a terminating comma) by treating the line that follows as a
comment line, just as is done on the mainframe.

Back to Top

Mainframe Access (MFA)

This release provides the following improvements:

• Running MFA client in 64-bit processes - you can now call the MFA client modules from 64-bit
applications and take advantage of the wider memory addressing available to those modules.

• MFA client CTF tracing - MFDAS now supports CTF tracing. This provides better diagnostics of issues
and helps increase turnaround on issues. CTF is common to a number of Micro Focus modules so
cross-component logging can be turned on from a single place.

• Endevor functions - the following functions are now available to Enterprise Sync and MFDAS: DELETE,
DIRX, GENERATE, GETENQI, LIST, MOVE, SIGNIN and TRANSFER.

Back to Top

The Micro Focus Unit Testing Framework

The Micro Focus Unit Testing Framework is now available from within the IDE. It includes much of the
architecture you would expect of an xUnit framework to create, compile, run and debug unit tests, including
the following features:

• A unit test project template.
• A test creation wizard that enables you to generate tests from your source code.
• Code snippets for each element of a test case.
• Support for running tests with Code Coverage enabled.
• The Micro Focus Unit Testing window, where you can manage your test runs and view test output.

There has been a number of enhancements to the command line version of the Micro Focus Unit Testing
Framework. Support has been added for:

• Generating NUnit-style reports.
• Running test fixture files using Apache Ant.
• Applying traits to your test cases, then performing a test run based on those traits.
• Applying a high, medium, or low priority to test cases, which affects the order in which they are run.
• Adding coded command line options directly into your test code.
• Using a test run-specific configuration file, in which you can set environment variables.

Back to Top

PL/I support

Enhancements are available in the following areas:

PL/I compiler and run-time system

Support has been added to enable the following:

• The UNSIGNED data type - the PL/I Compiler now supports the UNSIGNED attribute for FIXED
BINARY data items. In addition to the basic language support, the SIGNED, UNSIGNED, ISIGNED, and
IUNSIGNED new built-in functions have been implemented. These features offer an improved
compatibility with other languages such as C or C++.

• New built-in functions - UTF8(), UTF8TOCHAR(), UTF8TOWCHAR(), and SUBTRACT(). These new
build-in functions make it easier to modernize migrated PL/I applications.
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• The ENTRY LIMITED data attribute - the Open PL/I Compiler now accepts and fully supports the
LIMITED attribute on ENTRY declarations. This increases the compatibility of the Micro Focus PL/I
Compiler with IBM's PL/I for applications that you are migrating from the mainframe.

• Support for processing of JSON data - a number of new built-in functions are available for processing
JSON text. This enables you to modernize your PL/I applications by enabling them to interpret, create
and process JSON data.

JSONGETARRAYEND JSONPUTARRAYEND JSONGETMEMBER

JSONGETARRAYSTART JSONPUTARRAYSTART JSONGETVALUE

JSONGETCOLON JSONPUTCOLON JSONPUTMEMBER

JSONGETCOMMA JSONPUTCOMMA JSONPUTVALUE

JSONGETOBJECTEND JSONPUTOBJECTEND JSONVALID

JSONGETOBJECTSTART JSONPUTOBJECTSTART

PL/I macro preprocessor

A number of enhancements have been made to improve the compatibility between the PL/I macro
preprocessor and IBM's macro preprocessor which helps ease the effort required to migrate PL/I
applications to new platforms. Support is available for:

• RESCAN in the ANSWER statement.
• The shorthand "<>" syntax for indicating "Not Equal To".
• Break characters in hex literal constants to improve readability of code.
• A new option, -tagdbg, that annotates macros and %FILE/%ENDFILE statements with line numbers and

the source file which injected them.
• The -caseasis option which allows source code to flow through to the mdeck.pp file retaining the case

as entered.
• Macros with a null parameter list.
• The LEAVE statement.
• Improved macro preprocessing speed.
• New built-in functions: SYSENDIAN() and MFPHOSTNAME().

Back to Top

Rumba terminal emulator

Enterprise Developer now ships with Micro Focus Rumba 9.5.

Back to Top

XML processing

XML PARSE now works in a purely managed COBOL environment. It is now supported in JVM COBOL
and, in both .NET and JVM COBOL, it has a fully managed implementation. XML PARSE working without
calling out to native code ensures it can be used in restricted rights environments.

Back to Top
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Significant Changes in Behavior or Usage
This section describes significant changes in behavior or usage. These changes could potentially affect the
behavior of existing applications or impact the way the tools are used.

Where present, the numbers that follow each issue are the Support Incident Numbers followed by the
Reported Problem Incident (RPI) number (in parentheses).

• CICS Support
• Compatibility AddPack
• Compiler
• Documentation
• Enterprise Server
• Enterprise Server for .NET
• File Handling
• IDE
• IMS Support
• JCL Support
• JES-enabled Enterprise Server Regions
• Micro Focus Batch Scheduler Integration
• Micro Focus Directory Server
• OpenESQL
• PL/I Support
• Reserved words
• SQL: HCO for SQL Server
• HCO for DB2 LUW

CICS Support

Back to the list

• The value specified in the LENGTH field of the SEND TEXT command is now honored when the target
terminal has its SOSI or PS attributes switched on. This means that trailing spaces will no longer be
removed for SOSI/PS terminals.

2884877 (1107983)

Compatibility AddPack for Visual COBOL

Back to the list

Compatibility AddPack for Visual COBOL is now deprecated and will not be available with release 3.0 and
later.

The Dialog System GUI and run-time components and Dialog System Character Mode (on Windows and
UNIX) which were part of the AddPack are now installed as part of Enterprise Developer for Visual Studio.
The run-time components are installed as part of Enterprise Server. These are only included for backward
compatibility and Micro Focus does not recommend that you use them for new development.

The other components which were part of the AddPack, the Character-Based Data File Editor, CSBIND
and Screens, will be available upon request from Micro Focus SupportLine.

Compiler

Back to the list
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• Replacing a partial token no longer causes the second part of the token to appear on a new line. This
could happen if the new text was larger than the text being replaced.

2869185 (1105763)

Documentation

Back to the list

• There have been a number of new reserved words added to the language in this release; these are all
in effect under MFLEVEL"19", which is the default level when running under the MF dialect. Any of the
following words are now not allowed under default conditions, and you will need to remove/rename
them, or specifically configure your environment to allow them: ALLOCATE FREE JSON END-JSON

Enterprise Server

Back to the list

• WEB CONVERSE now supports a value of 0 for the USERLEN and PASSWORDLEN options which
matches the behavior on the mainframe. There is no change to the behavior of WEB SEND (client)
which is to return LENGERR 139/140 when USERLEN or PASSWORDLEN are 0.

2989188 (1108602)

Enterprise Server for .NET

Back to the list

• A problem that caused an RTS 173 error while executing a batch job step that performed a COBOL sort
(as opposed to EXEC PGM=SORT)when the program terminated using STOP RUN instead of
GOBACK has been fixed.

3105738 (1109359)

IDE

Back to the list

• Disabling CICS support from the properties of a file in your project within the IDE now correctly sets the
NOCICSECM Compiler directive on that file.

File Handling

Back to the list

• A problem that generated a 39 error when attempting to access a VSAM file via an alternate index
PATH element has been fixed.

2874622 (1106562)
• Under Mainframe emulation, when an empty virgin VSAM file is opened for input or for input/output, a

file status of 35 is returned, regardless of the access mode specified.

2692826 (1093604)

• New PARM option SIGN-EBCDIC documented for MFJSORT.

2880037 (1107256)
• The MFJSORT ICETOOL emulation now supports the USING parameter in the SELECT operator.

2821176 (1099529)
• An empty, space-filler record is no longer produced at the end of an ICETOOL listing file.

(622789)
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IMS Support

Back to the list

• Inconsistent results returned to a GET call issued from a PROCOPT=GO application when segments
within the same database record were updated and locked by another session. Symptoms included an
invalid (GE) status code or the wrong segment returned to a GN call. This has been fixed.

2862879 (1104899)

• The IMS control page is now secured according to the IMS* entity in MFESMAC.

2877405 (1107099)

JCL Support

Back to the list

• An emulation of the LE run-time option CBLQDA has been implemented in the form of the environment
variable MF_CBLQDA. The default is OFF, but when set ON, QSAM files can be dynamically created.

3104665 (1109251)
• A new event call to the JCL user exit (MFJUXIT) has been included. The event 'job-queued' (event code

27) occurs when a JCL job has been parsed and put on either the Input Ready queue or the Input Hold
queue.

2990395 (1108734)
• When reading commands, MFFTP now checks the charset (EBCDIC or ASCII) of each concatenated

INPUT dataset to determine if it should be translated. The output is written in the charset which
appropriate for the dataset.

2876407 (1106795)
• The PHYSFILE security setting will now be checked when a dataset entry is inserted into the catalog, or

when a dynamic PDS member is created.

2857819 (1104844)

JES-enabled Enterprise Server Regions

Back to the list

Important: Existing JES-enabled Enterprise Server regions must perform this upgrade to continue
using JES functionality. If you start a region without upgrading, the following message is displayed in
the console log, and JES functionality is disabled:

JES000058E JES validation - Product requires new spool control files. Run
spool conversion utility, splconv, to create them.

In this release, the infrastructure of the JES spool repository has been upgraded in order to improve
performance (see the Enterprise Server section of What's New for more details). For each JES-enabled
region, before you can submit any jobs to JES, you must run the spool conversion utility; any newly created
regions will automatically be configured to use the new spool files.

The conversion process converts the information in the existing spool files to a set of new files required
under the new system. There should be no loss of data in moving to the new system.

Important: After converting to the new JES spool infrastructure, we recommend that you do not
employ the increased range of job numbers until you have thoroughly tested the new infrastructure.
Reverting back to the previous JES spool files is possible, but requires that you remove all job entries
using more than 5 digits, for which there is no easy process.

To run the spool conversion utility

1. At the Enterprise Developer command prompt, set the following environment variables, as required:
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Variable Description

MFSYSCAT The location and name of the current JES catalog. This
is mandatory.

If multiple catalog files are being used (that is, one or
more user catalogs are defined), this environment
variable should point to the catalog where JES spool
datasets are cataloged.

MVSSPOOLDIR The location of the current JES spool files. This is only
mandatory if the location is different to the location of
the JES catalog.

NEWSPOOLDIR The location for the resulting JES spool files (that is, the
SPL* files if running the conversion, or the old-style
spool files if running the regression). This is only
mandatory if the location is to be different to the location
of the existing spool files.

MFSYSCAT_ERRS The number of catalog errors that will be tolerated
during the conversion process before the conversion is
terminated. This is optional, and defaults to 100.

If the process is terminated, the following error is
produced:

MVSCATIO Error limit exceeded = nnnn
(where nnnn is the error count)

2. Type splconv, then press Enter.

The conversion process runs, and details of the files and records converted are displayed to screen.
3. If MVSSPOOLDIR and NEWSPOOLDIR were set to different locations prior to running the conversion,

you must now set MVSSPOOLDIR to the value of NEWSPOOLDIR.

Note: If you do not perform this step, you will receive the following error when you start your
region, and JES fails to initialize:
JES000058E JES validation - Product requires new spool control files. Run spool conversion utility,
splconv, to create them.

4. You can now start the region identified by the variables, and begin to submit jobs.

Reverting to the previous JES spool repository

If you plan to downgrade to an older version of your current product, any enterprise server region that has
been converted or created with the current product will not be compatible. Before you can use them, they
must be reverted to using the old JES spool repository.

Use this process if you are wanting to use a JES-enabled region in a previous version of the product:

1. At the Enterprise Developer command prompt, set the environment variables listed in the To run the
spool conversion utility process, as required.

2. Set an additional variable, SPLREGR_TARGET, to PRE30.
3. If the region has started to use 6- or 7-digit job numbers (an enhancement new to version 3.0 of the

product), then before you run the regression, you must remove the jobs that are using these numbers,
and ensure that the MF_MVSJOB environment variable (or the SPLJNO.dat file if the variable is not
used) does not specify an upper limit greater than 5 digits.

Note: If using the MF_MVSJOB environment variable, to revert to 5-digit job number support, set
MF_MVSJOB=<low number>+<high number>, where high number is less than 0099999, and
ensuring that the + sign is used to separate the low and high values.

4. Type splregr, then press Enter.

The regression process runs, and details of the files and records converted are displayed to screen.
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You can now use the region identified by the variables in previous versions of Enterprise Developer.

Exporting the spool files to Enterprise Server for .NET

If you plan to export a region to Enterprise Server for .NET, any enterprise server region that has been
converted or created with the current product will not be compatible. Before you can use them, they must
be reverted to using the old JES spool repository.

Use this process if you are exporting a JES-enabled region to Enterprise Server for .NET:

1. At the Enterprise Developer command prompt, set the environment variables listed in the To run the
spool conversion utility process, as required.

2. Set an additional variable, SPLREGR_TARGET, to the appropriate value:
DOTNET5

Create spool files for use on Enterprise Server for .NET, using a maximum of 5 digits for
job numbers.

DOTNET7
Create spool files for use on Enterprise Server for .NET, using a maximum of 7 digits for
job numbers.

3. Type splregr, then press Enter.

The regression process runs, and details of the files and records converted are displayed to screen.

You can now use the region identified by the variables in Enterprise Server for .NET.

Micro Focus Batch Scheduler Integration

Back to the list

• MFBSI no more requires that the name of the last folder specified in the path in MFBSI_DIR matches
the name of the target Enterprise Server region. It is now possible to specify any directory path in
MFBSI_DIR. You must use the same value for MFBSI_DIR in both the Enterprise Server configuration
and for MFBSIJCL execution. When the name of the last folder specified in the path in MFBSI_DIR
does not match the name of the target Enterprise Server region, you need to specify the region name in
one of the following ways: 1. From the mfbsijcl command line, using the parameter
REGION=ESRegionName. 2. In an MFBSI configuration file, in a line containing
REGION=ESRegionName. You can specify this either in the default configuration file, mfbsi.cfg located
using the path specified by MFBSI_DIR, or using a custom location or configuration file and the
following parameter: CFG=[path]/name[.ext] See your product help for more details.

2869805 (1105939)

Micro Focus Directory Server

Back to the list

• In the Enterprise Server Administration HTML GUI, the "Scripts" page functionality is only available if
administration access is restricted and the logged on user has sufficient authority.

3101625 (1109025)
• Some additional CSRF security measures have been added to the Enterprise Server Administration

HTML GUI.

3101205 (1108916)

OpenESQL

Back to the list

The new OpenESQL OPTIMIZECURSORS SQL compiler directive option is turned on by default for both
ADO.NET (DBMAN=ADO) and ODBC (DBMAN=ODBC). For ADO.NET, this reduces cursor memory
consumption thereby providing optimal performance. This also ensures that, for ODBC, embedded SQL
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cursors that use WITH HOLD and FOR UPDATE clauses have the same data integrity across all
databases.

If your applications require the OpenESQL preprocessor to use the behavior provided in an earlier release,
compile them using OPTIMIZECURSORS=NO.

PL/I Support

Back to the list

• PUT output-items of type POINTER are now output as a hexadecimal string rather than a fixed bin
integer value.

(623184)
• Enterprise Developer 3.0 includes some changes that result in a significant performance improvement

when assigning a null character string '' to arithmetic data items, pointers, and structures. In versions of
the product earlier than 3.0, pointer = ''; assigned the value sysnull(). This has been fixed and null() is
now assigned. See the product help for details about the -setnull compiler option.

(627517)

• Previously, if writing output to a CTLASA (PRINT) file with the optional LINE(x) parameter having a
value of x that was less than the current line, PL/I did not generate ASA Control characters to end of
page and emit the output on the first line of the new page. This no longer occurs.

2871278 (1106114)

Reserved words

Back to the list

• There have been a number of new reserved words added to the COBOL language; these are all in
effect under MFLEVEL"19", which is the default level when running under the MF dialect. Any of the
following words are now not allowed under default conditions, and you will need to remove/rename
them, or specifically configure your environment to allow them:

ALLOCATE
FREE
JSON
END-JSON

SQL: HCO for SQL Server

Back to the list

• The HCOSS Assess Application Migration tool now enables you to view the original DB2 SQL and the
converted TSQL together in both the HCOSS tool itself and in any exported CSV files.

HCO for DB2 LUW

Back to the list

• Help buttons previously available on the XDB Server Configuration Utility, XDB Service Controller,
Options Dialog, Bind Utility, and Linker Config (Link Profile) UIs have been removed with the exception
of error messages in the SQLWizard, Migrate, and Declaration Generator.
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Known Issues
Refer to the Known Issues and Restrictions topic in the Product Information section of your product Help.

In addition, note the following:

• Azure support
• Debugging
• Enterprise Server
• Micro Focus Rumba
• Resource Adapters
• REST/JSON IMTK implementation and the same-origin policy (SOP)
• Visual Studio

Azure support

• When compiling COBOL Azure Role projects in Enterprise Developer for Visual Studio 2013 you
receive warnings at build time and the code fails to execute when deployed to Azure.

To work around this issue, you need to manually add the code below to the configuration section of the
Web.config file in your project for Web Roles or in the app.config file for Worker Roles:

<runtime>
      <assemblyBinding xmlns="urn:schemas-microsoft-com:asm.v1">
          <dependentAssembly>
              <assemblyIdentity name="Microsoft.Data.Services.Client" 
publicKeyToken="31bf3856ad364e35" culture="neutral" />
              <bindingRedirect oldVersion="0.0.0.0-5.7.0.0" 
newVersion="5.7.0.0" />
          </dependentAssembly>
          <dependentAssembly>
              <assemblyIdentity name="Microsoft.Data.OData" 
publicKeyToken="31bf3856ad364e35" culture="neutral" />
              <bindingRedirect oldVersion="0.0.0.0-5.7.0.0" 
newVersion="5.7.0.0" />
          </dependentAssembly>
          <dependentAssembly>
              <assemblyIdentity name="Microsoft.Data.Edm" 
publicKeyToken="31bf3856ad364e35" culture="neutral" />
              <bindingRedirect oldVersion="0.0.0.0-5.7.0.0" 
newVersion="5.7.0.0" />
          </dependentAssembly>
          <dependentAssembly>
              <assemblyIdentity name="Newtonsoft.Json" 
publicKeyToken="30ad4fe6b2a6aeed" culture="neutral" />
              <bindingRedirect oldVersion="0.0.0.0-8.0.0.0" 
newVersion="8.0.0.0" />
          </dependentAssembly>
      </assemblyBinding>
</runtime>

This information is added automatically when you create COBOL Azure projects in Visual Studio 2015
or later.
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Debugging

• When debugging .gnt code on early builds of Windows 10 and Windows Server 2016, execution fails
to stop at COBOL breakpoints. To resolve this, you should install the most recent Windows updates for
your operating system, as this problem is only known to be present with the earlier versions.

Enterprise Server

• On Windows 10, if you are using Microsoft's EDGE browser to access the Enterprise Server
Administration GUI, issues with EDGE can cause the automatic refresh feature to display a dialog
asking whether you want to resubmit a form. To work around this issue, cancel the resubmit request and
then refresh the server list page or the Home page of Enterprise Server Administration. You can also
turn off the automatic refresh by setting the Auto-refresh interval setting on the Home page of
Enterprise Server Administration to 0.

Micro Focus Rumba

• On versions of Windows Vista and later, Enterprise Server listens only on the IPv4 loopback address
(127.0.0.1). As a result, an attempt to connect to localhost with a TN3270 emulator such as Micro Focus
Rumba may fail. To work around this issue, in your emulator's configuration use 127.0.0.1 in preference
to localhost or your host machine's name.

• The embedded Rumba display is only available if you are using:

• Enterprise Developer for Visual Studio 2012 with Rumba 9.4 or earlier. If a newer version of Rumba
is installed, you need to use Rumba Desktop instead.

• Enterprise Developer for Visual Studio 2013, Visual Studio 2015 or Visual Studio 2017 with Rumba
9.5 or later. If an earlier version of Rumba is installed, you need to use Rumba Desktop instead.

Resource Adapters

• Trying to deploy the local resource adaptor mfcobol-localtx.rar to WebLogic may fail with a
ClassCastException. To work around this issue, you need to deploy mfcobol-xa.rar first, then need
to undeploy this file and deploy the local one, mfcobol-localtx.rar. If there are issues deploying
using the WebLogic GUI, you can use the command line. If there are issues with this as well, try
reducing the length of the command (for example, by moving the file to a location with a shorter path).

REST/JSON IMTK implementation and the same-origin policy (SOP)

• HTTP requests sent from scripts within a web browser to REST services deployed on an enterprise
server might fail due to the same-origin policy (SOP). Some browsers might implement (or support
plugins that implement) techniques for relaxing SOP such as cross-origin resource sharing (CORS) that
enable sending cross-origin requests successfully. For REST services, Enterprise Server does not
implement a method for relaxing SOP. This means that browsers that implement CORS (or any other
SOP relaxation technique) might still forbid requests made from scripts due to Enterprise Server not
implementing the equivalent technique on the server side.

Visual Studio

• The Visual Studio 2017 option Lightweight Solution Load is not supported for COBOL. It must not be
used with solutions that contain COBOL projects as it could result in problems with building the projects
properly.

• In certain installation scenarios, after you install Enterprise Developer for Visual Studio 2015, the
COBOL language service can be uninstalled. This results in the following features missing from the
COBOL editor: colorization, IntelliSense for COBOL and any other COBOL language support. This is an
issue with Visual Studio's MEF component cache becoming corrupted.

To resolve this issue and restore COBOL language support in the editor:
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1. From a command prompt, navigate to C:\Program Files (x86)\Microsoft Visual Studio
14.0\Common7\IDE.

2. Execute the following commands:

devenv /updateconfiguration

And then:

devenv /clearcache 
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Resolved Issues
The numbers that follow each issue are the Support Incident Numbers followed by the Reported Problem
Incident (RPI) number (in parentheses).

• Adis
• Assembler Support
• CICS Support
• COBOL to XML Schema generation
• Codeset Support
• Common Communications Interface
• Communications Server
• Compiler
• Data Tools
• Debugger
• Designer
• Documentation
• Editor Writing Assistance
• Embedded HTML Pre-Processor
• Enterprise Server
• Enterprise Server for .NET
• File Handling
• HCO for DB2 LUW
• HCO for SQL Server
• IBM Language Environment for OS/390 & VM Support
• IDE
• IMS Support
• Interface Mapping Toolkit
• JCL Support
• Mainframe Access
• Micro Focus Batch Scheduler Integration
• Micro Focus Directory Server
• Monitoring and Management
• OLE Class Library
• OpenSSL
• PL/I Support
• REX Support
• RM/COBOL
• Run-Time System
• SQL: COBSQL
• SQL: OpenESQL
• SQL Option for DB2
• XML Support

Adis

Back to the list

• PIC N items are now filled with double-byte space when required by ADISCTRL options 15 and 16.
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2913183 (1108448)

Assembler Support

Back to the list

• To provide EBCDIC to ASCII conversion, the Assembler directive ASCII has been added to generate all
character literals in ASCII instead of the default EBCDIC. For example: DC C'1' generates a hex 31
value instead of hex F1 when the ASCII directive is used.

2913358 (1108467)
• The copying of PDS files in Assembler is now supported. The assembler file handler now emulates

mainframe behaviour for opening/reading/writing/closing PDSs. This allows assembler programs to
open a PDS with these DCB settings: DCB=(DSORG=PO,RECFM=FB,LRECL=80,BLKSIZE=0) for both
input and output and copy a PDS with a simple read/write loop as on the mainframe.

2881923 (1108596)
• SVC 8 (LOAD) now sets the high order bit of the loaded module address as per the AMODE of the

loaded assembler module. If the module loaded has been linked AMODE(31) then the high order bit is
set in the returned address so it matches IBM mainframe behaviour.

2880278 (1107639)

CICS Support

Back to the list

• An issue causing a Communications Server failure during Cluster SEP recovery processing has been
fixed.

2883390 (1107785)
• A timeout on a global lock request for a CICS dataset, caused by the GLM not responding, could

generate an RTS 114 on dfh0msg in the requesting Cluster Slave.

2880992 (1107401)
• An issue with the _NOCONVERT option of CICS SEND FROM statements when a LU1 printer is used

as an output has been resolved. The control characters of the 3270 data stream are not meaningful to a
LU1 printer, and are no longer sent in such scenarios.

2877807 (1106961)
• Support has been added for the extended form of RECEIVE_ALLOCATE, "RECEIVE_ALLOCATE_EX",

to specify the alias of the local LU from which the TP will accept incoming attaches (IBM
Communication Manager only).

2877178 (1106980)
• A 64 bit CRTE or transaction routing request from IBM CICS mainframe to Micro Focus Enterprise

Server CICS now correctly returns the expected data.

2876499 (1106860)

• Programs that contain non-unique variables on a CICS command now produce a more specific error
message (COBEC1125 : Operand {operandName} is not unique) when compiled in an IDE.

2865273 (1105126)

• Terminating a SEP that is being waited on by another SEP no longer causes a corruption in the JCP/TD
return chain in the shared memory.

3107347 (1109532)
• An problem that caused a TASKIDERR to be returned on EXEC CICS INQUIRE TASK when the task

was greater than 9999999 has now been fixed.

3101286 (1109036)
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• A problem has been fixed that caused INQUIRE Terminal to return TERMIDERR when the terminal had
been installed from a resource definition and the terminal did not have a termtype.

2912829 (1108576)
• A problem with the CASTSC system module crashing when a START with data was executed during

region initialization has been resolved.

2886905 (1108257)
• An ASSIGN INVOKINGPROG in an XCTLed program now shows the correct program name.

2885264 (1108071)
• A problem that caused EXEC CICS SET FILE CLOSE statements to return an invalid request error

when the file was modified in the current task has been fixed.

2870461 (1106061)

• A problem with ESMAC display fields that enabled Authorization bypass and caused XSS-related issues
has been fixed.

3101205 (1108918)
• A problem in ESMAC that prevented TERM from accessing the related SYSC and SYS6 pages has

been fixed.

2881359 (1108307)
• The ESMAC > Clients page has been updated with a new Stop button that enables you to stop active

printers. In addition, you can now modify predefined printer terminal attributes and reinstall a printer
terminal.

2874807 (1106608)
• The Users button was sometimes unavailable in ESMAC. This has been fixed.

2860762 (1104487)

• CICS support has been updated to support the MQSUB API.

2878763 (1107270)

COBOL to XML Schema generation

Back to the list

• CBL2XML now handles namespace correctly.

2861655 (1104748)
• CBL2XML now correctly handles non-default type within <restriction>.

2826345 (1100279)

Codeset Support

Back to the list

• The Codeset DBCS tables MFTR0886.A2E MFTR0886.E2A have been updated to match the latest IBM
Traditional Chinese conversion tables below: Description of 9027: T-Ch Host Double-Byte including
6204 UDC including euro. Description of 21427: T-Ch DBCS-PC (IBM BIG-5) including 13493 CNS, 566
IBM selected, 6204 UDC & euro.

3104948 (1109314)

Common Communications Interface

Back to the list
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• Using CCI shared memory and receiving data with a max receive length less than the total amount of
data received resulted in the data being received incorrectly on the final receive. This has now been
fixed.

• After a communications failure, Enterprise Server shared-memory listeners would sometimes stop
accepting new connections. This has now been fixed.

Communications Server

Back to the list

• A path-traversal vulnerability has been fixed in the mfcs-esfadmin optional component of Enterprise
Server. This vulnerability could allow a user with network access to a suitably-configured Enterprise
Server region to download unauthorized files from the target system.

3101205 (1108925)
• In Enterprise Server, chunked HTTP requests now work with CICS Web Interface and CICS Web

Services servers.

3100279 (1108857)
• Persistent J2EE sessions to Enterprise Server could hang under heavy load, resulting in accumulating

idle transient SEP processes. This has been fixed.

2884386 (1108206)
• Enterprise Server's communications server (MFCS) no longer crashes in certain error-handling

situations, such as when sufficient memory cannot be allocated to handle an extremely large HTTP
response message.

2881711 (1107546)
• Enterprise Server now correctly enforces the order of responses to each client.

2874420 (1107167)
• An issue causing intermittent MFCS crashes at start-up due to heap corruption has been fixed.

2866204 (1105983)
• TN3270 conversations no longer hang, looping in the MFCS process, if the client sends a malformed

TN3270E header. A message will now be written to the MFCS log and the input record will be
discarded.

• An error handling bug in the MFCS Fileshare connector, which could cause a thread-termination error,
has been fixed.

• In some cases, MFCS could hang or crash some time after multiple threads abended within a 60-
second period. This has been corrected.

• HTTP path-traversal vulnerabilities, which could lead to information exposure, have been corrected in
Enterprise Server's MFCS component.

Compiler

Back to the list

• Level-88 VALUE clauses that inadvertently contain fixed point numeric literals, which cannot be
matched with the associated numeric type, are now flagged with an E-level message.

3106909 (1109479)
• A new ARITH"COMPAT|EXTEND" Compiler directive is now supported to emulate the IBM mainframe

option of the same name. This option defines the maximum number of digits for numeric data items.

3105597 (1109340)
• An extended ACCEPT of a PIC N data item now compiles successfully, as expected.

3101615 (1108944)
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• The reference to an ASSIGN name in the SELECT clause is now included in the IDE's 'Find All
References' list irrespective of whether the ASSIGN name is explicitly declared later in the source or
not.

3100084 (1108817)
• When an intrinsic function is used as a parameter to an inline method invoke, which is also a parameter

to another inline method invoke, the Compiler would produce invalid code, leading to a COBRT200
error. This is now fixed.

2991106 (1108786)
• Prototype checking for OMITTED parameters in inline method invokes is now working as expected.

2991031 (1108800)
• An error when an OBJECT PROPERTY is used in subscript calculation, or reference modification index

or length calculation, has been fixed.

2990388 (1108738)
• A directives file with an explicit end of file character is now processed correctly.

2913115 (1108474)
• A DISPLAY of ADDRESS OF <data item> now executes as expected.

2913005 (1108635)
• Prototype checking for nested inline method invokes is now working as expected.

2912463 (1108437)
• A bug where compilation of very large managed projects could fail with error "COBCH1500: memory

allocation failure – module 'allocmem'" has been fixed.

2886156 (1108156)
• Using COBSQL with CP for a program with complex multi-line COPY REPLACING no longer results in

spurious errors.

2884493 (1107939)
• A move from a group to a reference modified PIC N field now executes as expected.

2884093 (1107883)
• Sign-included numeric usage DISPLAY items now display as expected under a mainframe dialect; that

is, they display with the included sign shown exactly as stored, without conversion for readability.

2879364 (1107340)
• The use of N" national literals in STRING statements no longer produces incorrect results.

2878504 (1107053)
• A bug where COBDATA was set prior to starting the Visual Studio IDE, and was then blank when

applications were executed, has been fixed.

2878431 (1107160)
• A user class condition where the subject has the potential to be zero length now compiles and executes

as expected when compiled with a mainframe dialect (which sets the ZEROLENGTHFALSE directive).

2878426 (1107044)
• The same names used for data items in both method local and object storage could sometimes result in

wrong execution results when the wrong duplicated name was used.

2878370 (1107207)
• Class conditions defined in the SPECIAL-NAMES paragraph now work when SELECT statements are

defined before the SPECIAL-NAMES paragraph.

2876808 (1106853)
• Under CHARSET(EBCDIC), a MOVE of PIC G/N data items to PIC N/G data items now pad with

x"4040" (an EBCDIC DBCS space). Comparisons of such data items will now also work correctly.

2876109 (1106752)
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• VALUE clauses with hex literals now pad correctly with x"40" under CHARSET(EBCDIC).

2875748 (1106704)
• Statements involving properties and 'OCCURS DEPENDING ON' tables now compile and execute as

expected.

2875074 (1106626)
• Concatenation of alphanumeric literals in a VALUE clause for a national item is now treated as

intended.

2873871 (1106451)
• Queries of reference modified national data items now work as expected.

2873639 (1106443)
• Using INSPECT <national-data-item> with the BY SPACE clause now works as expected. When dealing

with national data items, SPACE is now treated as a national space - NX"0020£.

2873388 (1106390)
• A user class condition test, where the item being tested is a reference modified item with a length that is

an expression, and when the directive ARITHMETIC(OSVS) is set, no longer causes an internal error
on compilation.

2873219 (1106409)
• Nested inline method invokes now work as expected.

2872741 (1106315)
• A MOVE statement referencing a property name now compiles and executes as expected.

2872488 (1106304)
• A program containing DBCS characters in the sequence area of an otherwise blank line now compiles

correctly and without error.

2868802 (1105699)
• An issue with using DECLARATIVES without a USE statement has been fixed.

2867168 (1105446)
• If more than one report shared the same FD, for example: REPORTS ARE REPORT-1 REPORT-2. then

under HOSTRW, the record length was wrong. This has been corrected.

2865849 (1105553)
• The use of the HOSTRW and CURRENT-DATE directives no longer causes an excessive number of

lines in a report produced from the Report Writer.

2853789 (1105472)
• A USE FOR DEBUGGING statement that references a table item and is triggered by a condition where

the table item is referenced but not evaluated (due to short-circuit evaluation) now executes as
expected.

2433731 (1073167)
• A bug in the Compiler, when REPLACE is used and the final line in the main source file is a copy

statement containing a separate program, has been fixed.
• An error reporting the size of return-code by the Eclipse IDE has been fixed.

• A bug has been fixed in programs compiled with CHECKDIV"OSVS" that contain a statement of the
form: COMPUTE r = a / (b - b)

3105637 (1109410)
• A bug in ON SIZE ERROR for arithmetic statements using floating point variables has been fixed.

2886077 (1108151)
• A bug has been fixed in generated code on Linux/390 for statements of the form: compute rounded a =

b / constant where a and b are both comp-3 variables, and constant is an integral power of 10 (e.g. 10,
100, 1000).
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2874143 (1106479)
• A COBRT114 error that was occurring at run time in generated code has been fixed.

2871410 (1106100)
• An error in debugging on Intel 32-bit platforms, such that a breakpoint set on an "exit method" statement

is ignored if it immediately follows a statement such as "end-perform", "end-if" or "end-evaluate", has
been fixed.

2861424 (1104587)
• A bug in generated code with the opt(3) directive, on Intel x86 64 bit (Linux and Windows) and

Linux/390 has been fixed.

• A spurious warning 'Reference to undeclared extern assembly' is no longer generated for programs
using the PREXML preprocessor, when built in Visual Studio.

3106908 (1109475)
• Icons consisting of PNG images are now being loaded successfully into applications using the ILICON

directive, and no longer causing compile-time errors. (The ILICON directive is generated implicitly in
Visual Studio when an icon is selected in the 'Icon and manifest' drop-down in Project Properties.)

2988305 (1108523)
• In some cases, use of the PROFILE directive could generate invalid code; those cases have been fixed.

2882325 (1107625)
• If the level 66 RENAMES phrase refers to two items in different 01 level records (which is non-standard

and not recommended), the offset of the resulting item is no longer calculated wrongly; previously it
was, leading to incorrect behavior at run time.

2882119 (1107568)
• If the first procedure in a PERFORM...THROUGH statement terminated (e.g. with GOBACK or STOP

RUN), then the PERFORM itself terminated, and control did not trickle through beyond the PERFORM
statement. The compiler has now been modified to recognize this condition, which means that the
procedure division can be broken down into disjoint methods, avoiding stack overflow during program
execution.

2880315 (1107465)
• An arithmetic expression involving an intrinsic function and a non-integer COBOL numeric item (e.g.

PIC 9V9) no longer produces a result with incorrect decimal alignment.

2878918 (1107116)
• A load failure, which was the result of bad code caused by a constructor containing a GO TO statement

that referenced a label (either a section or a paragraph) at the start of the procedure division, no longer
occurs.

2878817 (1107114)
• The use of report-writer syntax in a class program no longer leads to bad code generation. Previously, it

could result in 'field not found' errors when the class was loaded.

2878260 (1107158)
• When a PIC X data definition is used as a parameter to a method expecting an IEnumerable<char>, or

when used as the object for an extension method on IEnumerable<char> (e.g.
System.Linq.Enumerable.ToArray<char>), bad code is no longer generated.

2877859 (1106974)
• Use of the DIALECT"ENTCOBOL" directive no longer causes incorrect behavior when dealing with

EXTERNAL files.

2875493 (1106685)
• When compiling for managed code, specifying an object reference in the file section will now produce

an appropriate error message. Previously, the Compiler was allowing the use of object references in the
file section, which was causing the generation of bad code, and inappropriate system error messages.
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2872605 (1106287)
• Report Writer syntax directly under class-id (that is, not within static/end static or object/end object) no

longer causes the generation of invalid code, which was leading to errors at run time.

2872555 (1106283)
• In managed COBOL, a large amount of CONTROL clauses no longer causes the SCREEN SECTION

to produce a buffer overflow.

2870942 (1106053)
• When ILSMARTLINKAGE was specified for a program compiled with the directive ODOSLIDE (which is

set automatically when a mainframe dialect is used), and when the program contained a linkage section
record with multiple OCCURS DEPENDING ON items, then illegal code was being produced with
multiple error messages. This is now fixed.

2870166 (1105899)

Data Tools

Back to the list

• Vision and RM files that contain a null (0x00) byte in the key now function correctly in the Data File
Editor.

2882159 (1107598)

• The following minor enhancements have been made to the Data File Editor: - Previous filter conditions
are now remembered for each file when the dialog is loaded. - The default filter operator now defaults to
'Contains'. - Field attributes for reference conditions now default to 1:max-rec- length, instead of 1:1.

2878521 (1107104)

Debugger

Back to the list

• Querying DBCS items in Character Animator now works as expected.

3107408 (1109521)
• The debugger no longer hangs when debugging remote Enterprise Server regions.

2882367 (1107659)
• Examining the value of large data items in 64-bit applications or when debugging remote applications

no longer causes the debugger to exit.

2872732 (1106322)
• When debugging .gnt code, execution fails to stop at COBOL breakpoints. To resolve this, you should

install the most recent Windows updates for your operating system, as this problem is only known to be
present with early Windows builds of both Windows 10 and Windows Server 2016.

Designer

Back to the list

• File Handler no longer goes into a loop when trying to read an empty mainframe file.

2877027 (1107020)

Documentation

Back to the list

• The product documentation has been updated to include information and syntax for secure access to
MFDS (mfds /b).
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2854625 (1103606)
• Documentation for environment variables has been improved.
• The product documentation has been updated to include the MFA_INDEX_FORMAT environment

variable used in configuring the Enterprise Server.

2278928 (1066511)

• The casstart /w parameter prevents the casstart process from exiting until the region has either started
or failed to start correctly.

2868898 (1105712)

• A "redundant" or "high-availability" mode is now available in the Enterprise Server External Security
Facility. It enables you to configure multiple equivalent Security Managers and let processing continue
as long as at least one Security Manager is available. To enable this feature, add the following to the
configuration text area for the security configuration (either in the default Enterprise Server Security, the
MFDS Security, or on the Security tab for a specific enterprise server): [Operation] redundant=yes

2989911 (1108665)
• The Enterprise Server documentation no longer includes the PL/I programming guide as it includes

information about editing, compiling and debugging PL/I programs which are not under in Enterprise
Server.

2877789 (1107019)
• Additional information on the Web Services and J2EE conversation type has been added to the

"Configuring Listener Conversation Types" chapter in the product documentation.

2877270 (1106896)
• The product documentation has been updated to include information on converting the input file used by

casrdtup from EBCIDIC to ASCI.

2863611 (1104940)
• The documentation for bit zero of the 'thread-state' parameter of CBL_THREAD_LIST_START and

CBL_THREAD_LIST_NEXT has been corrected.
• Documentation of CBL_LOCATE_FILE parameter corrected.

• The installation instructions included incorrect information about users having to stop and uninstall an
existing Micro Focus Directory Server (MFDS) or CCITCP2 Windows service (on Windows) or a
process (on UNIX) from an existing product. This has been removed from the product help.

2877431 (1106934)

Editor Writing Assistance

Back to the list

• IntelliSense and Content Assist now provide the appropriate suggestions after a CONTAINS expression.

Enterprise Server

Back to the list

• An issue where SOAP elements were not mapped to COBOL code has been resolved.

3106199 (1109416)
• When SOAP headers were part of the SOAP request, you no longer receive a "SOAP header

malformed" response.

3105803 (1109367)
• An issue where a handler program in the pipeline caused issues with JSON GET/DELETE/HEAD

requests has been fixed.

3104977 (1109274)
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• An UNDEFINED_ELEMENT error message occurred when a JSON message (under CICS WEB
SERVICES) did not include an object that was present as a "record 1" item in the wsbind or the jsbind
files.

3102943 (1109085)
• When a CICS Web Service was invoked with no port in the URI, the default port for the scheme was not

set up.

3100280 (1108870)
• EXEC CICS SEND and CONVERSE commands now send all user-written headers (EXEC CICS

WRITE HTTPHEADER) even if the user provided values that contain null bytes. When browsing
headers with EXEC CICS WEB READNEXT HTTPHEADER, CICS will now initialize the buffers that
were supplied for the header name and value.

2990561 (1108733)
• A problem where a system process (CASTRC) was unable to allocate any local storage and, as a

result, became unresponsive, has been resolved.

2886741 (1108236)
• Casout commands running in a loop from the same process used to exhausting resources. This was

caused by an invalid path concatenation.

2886407 (1108426)
• An issue resulting in a Run-Time System error 205 "Invalid mainframe pointer" has been fixed.

2885280 (1108041)
• TRANSFORM was failing in situations where an XMLTODATA TRANSFORM contained an XML

declaration with EBCDIC encoding.

2885262 (1108040)
• The EZASOKET traces are now controlled by a COMMS trace flag.

2884491 (1108174)
• Caching has been added for TS queues security checks.

2884070 (1108789)
• Commarea overrides are now honored for non-facility transactions.

2884049 (1107879)
• Usernamelen and passwordlen options are not mandatory on exec cics web converse and web send

(client).

2880669 (1107365)
• Previously, using multiple CICS LINK statements (linking A to B to C and so on) could result in an RTS

error 114 in the CAS system modules.

2880542 (1107372)
• The spool active job queue will now display any jobs that were started prior to resetting the time for DST

but that have not completed yet.

2879116 (1107204)
• The debug file name generated when using CICS Web Services now includes the process ID and the

task number. For example - inquireCatalogClient-19556(00028)-CWS-REQUESTER.TXT.

2878485 (1107077)
• The SOAP to COBOL mapping under CICS Web services was incorrect when an optional element had

no child elements (where the schema defined a minimum of one such child element and these child
elements have been mapped to a container). In such cases, the number of instances of the child
element would have an incorrect value of 1 where it should be 0.

2877043 (1106879)
• If you used XA with more than 7281 transactions or had a number of JCL jobs that used XA, a record

could be split across multiple blocks. After restarting the enterprise server, a large number of
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CASXO0029I errors were reported in the console log file. A block that can hold up to 7282 records is
now used.

2874024 (1106469)
• When casout is used to release a job, casmgr now attempts to dispatch the job immediately rather than

waiting for its next dispatch cycle which previously could take 20 seconds.

2873224 (1106621)
• If there were more than 20 TRANCLASS instances specified in the startup list, this could cause

memory corruption.

2868129 (1105682)
• The ESFCA0401I Cache Termination message is now available for JES, IMS DB, IMS TM, MQ, and

iFileshare processes.

2866750 (1105376)
• A duplicate security check about whether the user has enough permissions to run a JCL job has been

removed.

2866526 (1105336)
• When eci-tpn is used on a call to ECI for CTG or the Micro Focus implementation of ECI, Enterprise

Server now verifies the transaction exist and is enabled. If the transaction is disabled, an abend AZI6 is
returned. This is mainframe-compatible behavior.

2863500 (1105165)
• An EXEC CICS LINK to a non-CICS module now handles the data context correctly and you no longer

receive CDCD abends on any further LINKs.

2858747 (1104275)
• CASxx5006I messages now display a return code.

2853609 (1103516)
• All ESMAC pages are now secured. Users who are not authorized now receive an error message when

trying to access any of these pages in their browser.

2843901 (1102247)
• The CICS WEB services now support SOAP 1.2.

2822822 (1099723)
• An issue that could cause an RTS error 119 on a casout command when starting a batch initiator has

been fixed.

• An issue with certain length DNs that could cause DNs to become truncated has now been fixed.

3103303 (1109366)
• If nested groups (user groups containing other groups) were used with LDAP-based security for

Enterprise Server, it could result in Enterprise Server hanging at region startup, or users might not be
assigned all of their groups. This has now been fixed.

2988205 (1108935)
• The "check TLQ first" option has been added to the MLDAP ESM. The option can change the Rule

processing algorithm. This option might improve performance when there are large numbers of
resources in a class.

2875051 (1106874)
• Enterprise Server no longer crashes on startup if LDAP-based external security with the "all-groups"

and "redundant" options are both specified, but the "federated groups" option is not.

2874010 (1106529)
• If the esfupdate utility is used to request an update of security information for a user, and that user was

originally signed onto the system using a lowercase representation of their user ID, the update now
correctly identifies and updates the user.
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2871297 (1106164)
• If the MFDS Security Configuration specifies that verify requests should be cached and the cache TTL

and limit values are non-zero, for example, the MF Directory Server Security configuration page
Security Facility configuration text contains: [Cache] requests=verify If a new password was specified in
a Web interface logon request, then previously it was being ignored. Previously, if the user was logging
on with an expired password and attempting to change the password the request would also be ignored
and an expired password error would be returned.

2868342 (1105626)

• An RTS 205 error during the execution of an AMODE application could occur when Assembler address
0 was erroneously de-registered. This is now fixed.

3104561 (1109229)

• Under heavy loads, the ESFCA0401I log messages were not appearing at the correct intervals.

2863222 (1104948)

• Enterprise Server listeners that are configured for TLS (also known as SSL) no longer hang if a client
connects to them without sending any data.

2873177 (1106408)
• In some HotFix releases of earlier versions of Enterprise Developer and Enterprise Server, SSL or TLS

connections to an Enterprise Server could hang if client certificates were used and there was a delay of
at least several seconds before the certificate was sent.

Enterprise Server for .NET

Back to the list

• A rare intermittent exception could occur during region shutdown due to old listener information.
• Under Enterprise Server for .NET, a NullReferenceException occurred when attempting to use CFCR to

create a file that already exists, but had not previously been accessed by the SEP.
• Enterprise Server for .NET region shutdown no longer fails if one or more registered listeners cannot be

contacted. Any WCF exceptions that occur while attempting to contact the listeners are still logged to
the Windows event log.

• A problem that caused region database access exceptions when using VSAM share options for a CICS
region running under Enterprise Server for .NET with user impersonation security enabled has been
fixed.

• A problem that caused JCL job submissions to fail under Enterprise Server for .NET due to region
database timeouts has been fixed.

3102219 (1109110)
• A problem that caused a performance degradation on running jobs or job submissions when Enterprise

Server for .NET's Spool View containing a large number of spool entries was refreshed from the MMC
UI has been fixed.

3102219 (1109280)
• A problem that caused an application invoked via IKJEFT01 to loop when the output line limit had been

reached has been fixed.

3101438 (1108934)
• A problem that prevented Force Stop on a JES region from cancelling active jobs has been fixed.

3100999 (1108890)
• A dataset name filter entered in the Enterprise Server for .NET MMC UI Catalog view sometimes

caused incorrect dataset names to display. This has been fixed.

2990872 (1108763)
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• When using the Region Startup File Editor in Enterprise Server for .NET, the description for the
"Maximum lines" property of a JES region startup file did not make it clear that the units are in 1000s.
This has been fixed.

2990413 (1108717)
• The Enterprise Server for .NET MMC UI Catalog view has been updated to improve the performance of

refreshing very large numbers of catalog entries.

2989721 (1108650)
• The Enterprise Server for .NET public class library has been enhanced with new overloaded

ReadRecString and ReadRecBytes methods for the JesFile class. These new overloaded methods take
a JesFileReadOptions enum as a parameter to specify whether trailing spaces and nulls should be
trimmed from the returned record.

2988999 (1108626)
• A problem in the Catalog view of the Enterprise Server for .NET MMC UI when allocating a dynamic

PDS caused the "OK" button to be enabled before the PDS allocation folder and at least one JCL
extension had been specified. This has been fixed.

2988432 (1108546)
• The Catalog view in the Enterprise Server for .NET MMC UI can now be configured to restrict the

number of entries displayed.

2912396 (1108403)
• Batch SQL applications invoked by IKJEFT01 running under Enterprise Server for .NET could be

repeatedly invoked if the database connection was lost.

2887793 (1108359)
• In the Enterprise Server for .NET MMC-hosted administration console, the "Sign On" button for JES

spool and other functions was working incorrectly if the region file was kept in the cross-region
database. This has been fixed. Also, in a case where the region file cannot be processed, clicking the
"Sign On" button now returns a message box describing the error instead of returning the "Sign On"
dialog box. Note: Regions that are correctly configured with no security continue to display the "Sign
On" dialog box, and any valid user name and password combination is accepted.

2887759 (1108468)
• A problem with the Enterprise Server for .NET LogonEsm security module causing a null reference

exception when running under the MMC Administration UI has been fixed.

2887759 (1108469)
• A problem that prevented Enterprise Server for .NET from recovering tasks that were running on a

machine that died or was powered down has been fixed.

2887661 (1108354)
• The Enterprise Server for .NET MMC UI's Spool View now allows sysout records being written to by a

running job step to be displayed.

2887657 (1108364)
• Repeated clicking on the "Read to end of file" button in the file viewer of Enterprise Server for .NET's

MMC UI could sometimes result in corrupt output.

2882134 (1107676)
• The Enterprise Server for .NET public API documentation has been updated to include code samples

for the JesFile class.

2882073 (1107569)
• The Enterprise Server for .NET documentation has been updated to included information about how to

configure an event monitor's dispatcher endpoint, and what database permissions are required for a
user when debugging.

2878273 (1107018)
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• Under Enterprise Server for .NET, attempting to kill an active job in a SEP process that had died
resulted in the event monitor process unexpectedly terminating.

2873643 (1106419)
• When a SEP pool process in Enterprise Server for .NET dies (for example, when debugging stops or a

StackOverflowException is received), any orphaned running tasks from that process will now have any
associated resources released (such as ENQ locks, initiators, or printers).

2873623 (1106417)
• The Catalog view in Enterprise Server for .NET's MMC UI was sometimes truncating the list of datasets

displayed if one or more of the datasets in the catalog were dynamic PDSs.

2873448 (1106412)
• When allocating a dynamic PDS, the Enterprise Server for .NET MMC UI now mandates the entry of

both the folder path and one or more extensions. Previously, an invalid catalog record was created if an
extension was not specified. This resulted in "An unknown error occurred" message being displayed by
the Catalog view when it attempted to retrieve it.

2873448 (1106410)
• Under Enterprise Server for .NET, dependent assemblies of user programs could fail to load if they were

not loaded in the same task as their parent assemblies.

2872498 (1106291)
• The Enterprise Server for .NET public JesSpoolRecSysout class now exposes the RECFM of the

sysout dataset as a property.
• In Enterprise Server for .NET, a JES region configured to use LDAP-based security now correctly

processes jobs that are submitted with a user ID and password.
• A problem that caused an InvalidCastException when browsing a database-hosted extended ESDS file

using Enterprise Server for .NET has been fixed.

• The Enterprise Server for .NET MMC UI did not report any error if you ran it as a user with insufficient
database permissions to allow the reading of a region's console messages. The topic "To Configure
Process Logon Credentials" in the product help now includes details of which database permissions
need to be assigned for which operations if the MMC UI user cannot be assigned database sysadmin
privileges.

2876165 (623134)

Embedded HTML Pre-Processor

Back to the list

• The XML run-time system did not handle data items with the OCCURS clause correctly.

3107418 (1109566)

File Handling

Back to the list

• The ESF LDAP Security Administration Web Interface now has a logoff button.

2871551 (1106117)
• CICS SYSOUT output now displaying correctly in the Classic Data Tools editor. Some recent changes

to determine whether or not in-stream data needed to be converted to/from EBCDIC were causing the
problem.

2883885 (1107847)
• If data compression is specified when trying to open a fixed block file, when running under a mainframe

dialect, the File Handler now checks to see if it is trying to open a VB file. If it isn't, compression will be
turned off and the file will be opened as normal.

2870022 (1105956)
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• An internal field used to store the current file status was being overwritten by the allocation of a buffer.
Now we store it off beforehand so its value can be restored, and an accurate file status returned.

2868664 (1105707)
• When certain in-flight rewritten records were rolled back at the end of a transaction, the File Handler

was setting incorrect values for the length field in some records and various warning messages were
displayed during index file validation.

2864802 (1106106)

• A CBL_FREE_MEM statement in Fileshare was missing a 'by value' clause, which was causing a run-
time error. This is now fixed.

2883421 (1107767)
• When running under Fileshare, a delete on a locked record no longer results in a record locked status if

the same user had previously obtained a read lock on the file.

2832909 (1108287)

• When REBUILDing from SEQ into IND with duplicate key, you will no longer get a corrupted file if you
do not specify the target flag /t.

2880311 (1107302)

• CSF to ZD negative sign conversion is now handled correctly during a sort operation.

3103118 (1109125)
• JCL SORT no longer abends if no record is rewritten to a DUMMY data set.

3102468 (1109052)
• Sorting ESDS files to RRDS files no longer truncates the first 4 bytes of each record.

3101385 (1109112)
• Variable length SORT OUTFIL files are now created correctly when more than one data set is specified

in the targeted OUTFIL.

2881629 (1107551)
• MFSORT INCLUDE will no longer include the first record in the concatenated file if, according to the

parameters, that record should be excluded; previously, the first record was included regardless of the
parameters.

2876259 (1106785)
• For an MFJSORT, a combination of numeric tests and logical comparisons now returns the correct

records.

2870986 (1106216)
• When copying concatenated files in MFJSORT, for sequential fixed block, the correct number of record

is now used.

2870506 (1106057)
• MFJSort now produces the correct number of records regardless of the value of the SORTSPACE

setting.

2867668 (1105534)
• An error when writing the ICETOOL listing from an empty input file has been corrected.

2866176 (1106459)

HCO for DB2 LUW

Back to the list

• The HCO DCLGEN tool has been updated to generate PL/I copybooks with valid definitions for graphic
and decimal data types and to compile cleanly with the PL/I -mvs option.
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3105260 (1109306)
• A problem that sometimes occurred when using the DB2(NOHCO) compiler directive option caused the

return of incorrect codes at completion of program execution. This has been fixed.

3100172 (1108872)
• The DB2 preprocessor has been updated with a new DB2 compiler directive option, QUALIFY-CALL,

that works with the QUALIFIER compiler directive option to qualify DB2 EXEC SQL CALL statements
with the schema name specified by the DB2 QUALIFIER directive.

2884948 (1108032)
• The DB2 ECM has been updated to prevent an undefined ECM error when indicator variable arrays are

used in SELECT SQL statements.

2884605 (1107947)
• The DB2 ECM preprocessor has been updated to support host variables defined as SQL TYPE IS XML

AS BLOB-FILE/CLOB-FILE/DBCLOB-FILE.

2839654 (1101707)

HCO for SQL Server

Back to the list

• HCOSS handling of the DB2 CHAR scalar function has been enhanced for date and time conversions.

3103159 (1109143)
• The OpenESQL preprocessor has been updated to reorder certain SQL compiler directive options to

prevent the generation of a COBES0121S error.

2883191 (1107806)

IBM Language Environment for OS/390 & VM Support

Back to the list

• The Language Environment (LE) utilities are now available for managed COBOL applications in both
ILGEN and ILVERIFY formats.

2843311 (1102161)

IDE

Back to the list

• Attempting to evaluate a class condition when debugging .NET COBOL code could cause the debugger
to crash.

2887005 (1108289)
• Previously, you could only use the environment variables specified using the "Environment" button on

the Application tab in the project's properties when running the project. There is now a new option, "Use
variables when building the project", which enables you to apply these variables when the project is
compiled.

2881792 (1107641)
• Restarting debugging of native projects is now successful.

2878077 (1107005)
• Native COBOL projects that contain an Application.config file now build cleanly when this file is read-

only.

2875625 (1106694)
• The Web Publish option now works correctly for COBOL ASP.NET applications.

2875454 (622986)
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• The COBOL margins are now displayed correctly when stepping into an assembly that is not part of the
solution being debugged.

2874876 (1106604)
• The performance while stepping through a Mainframe Subsystem application running on a remote

machine has been improved.

2871769 (1108698)
• It is now possible to create projects in folders that contain accented characters.

2858012 (1104133)
• By default, Visual Studio is now configured to insert spaces in the COBOL code when the tab key is

pressed in the editor. If you are upgrading from an earlier version of this product, and have changed
your tab settings, they will be reset to the default IDE settings as part of the upgrade. For Enterprise
Developer, this change also applies to Assembler, BMS, IMS, JCL and PL/I programming code.

IMS Support

Back to the list

• Erroneous file status 46 messages appearing on the Enterprise Server system console have now been
fixed.

2886926 (1108578)
• An IMS syncpoint failure that intermittently occurred at job termination, depending on the timing of

events, has now been fixed.

2877595 (1107134)
• This RPI described the situation where a "GU" call using a pcb with the PROCSEQ option on a

secondary index was incorrectly returning the primary key, not the secondary index, in the pcb key
feedback area. This fix returns the secondary key or index in the key feedback area.

2877248 (1106941)
• A new warning message has been added to indicate when a checkpoint call is delayed due to a

duplicate checkpoint ID. In addition, the ES_IMS_BASIC_CHKP_OPT environment variable has been
added to provide additional checkpoint optimization that enables a basic checkpoint call to process as if
a SYNC call had been issued.

2875685 (1107227)
• IMSLOGR file access errors that sometimes occurred on the IMSLOGR.DAT checkpoint log file when

two or more IMS BMP applications shared the file have been fixed.

2872783 (1106751)
• A batch IMS program that terminates abnormally now flushes subsequent job steps in the JCL.

2864940 (1105315)
• An RTS114 message was sometimes issued during the CASDBC process on a system running under a

heavy IMS DB load. This has been fixed.

2860205 (1106684)
• The Start and Stop DB commands failed to reject non-existent DBs.

2857756 (1104092)
• A problem with the behavior of an EXEC DLI application accessing a USERDB exit has been fixed.

2849576 (1102989)
• A problem that prevented IMS from making the connection to the DB2 subsystem via DSNALI when

JCL is running the DNSMTV01 program, in batch mode has been fixed.

2846683 (1102634)
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• The MFS generator has been updated to issue an error message when adjacent output screen fields
are not separated by a space. To correct the problem, edit the MFS source to include a space between
the fields.

3101284 (1109215)
• A new MFS compiler directive, CONTMVS, has been added to enable the compiler to parse imperfect

MFS continuation lines just as on the mainframe, meaning that when it encounters a line in the MFS
source that is continued without a terminating comma, it treats the line that follows as a comment line.
When CONTMVS is not specified, terminating commas are assumed, and the next line is treated as a
continuation of that line.

3101284 (1108961)
• The MFS generator has been updated to generate the extended color attribute only when specified in

the MFS source, enabling the default colors in the PCOMM 3270 emulator to take precedence.
Regenerate MFS source after adding the extended color attribute.

2887354 (1108314)
• The SYSMSG field was right-justified and this was causing a problem with displaying the output format.

The output format is now displayed correctly.

2885315 (1108134)
• The printed report page is now padded with blank lines if the number of lines is less than the number of

lines per page specified in the MFS source. This only applies if the PAGE parameter is
PAGE=(n,SPACES).

2885281 (1108042)
• An error message is now sent to the terminal if the input consists of null segments.

2882071 (1107587)
• High-value (x'FF') bytes are no longer incorrectly removed from inbound TN3270 client data.

2880275 (1107581)
• The trancode was being stored in a screen device field with non-modifiable extended attributes. When

resending the output screen (write command), the MDT was not being set. Input of the trancode was
not being transmitted, resulting in a DEST NOT FOUND message. To implement the fix, you must
regenerate the MFS.

2876099 (1106859)

• The IMS preprocessor has been updated to determine whether a job is a normal start or a restart by
looking only at the first five bytes of the checkpoint ID, as is done on the mainframe, ignoring additional
bytes if the first five are spaces. In addition, when a checkpoint ID is determined to be invalid, the
EBCDIC value of the ID is converted to ASCII before writing it to the job log.

3107216 (1109583)
• An RTS 173 occurred at end of a job when an MQ entry point call at the end of step to clean up was

unloaded by canceling the MQ modules. This has now been fixed.

2872962 (1106368)
• DLI status codes FD (deadlock loser) and BD (lock timeout) returned to a CICS application did not

ABEND as they should have. These status codes now properly trigger an ADCD transaction ABEND.

2864939 (1105080)

• The IMS-TM "Trailing space" property was ineffective for EBCDIC transactions. This has been fixed.

2880919 (1107479)
• A problem when connecting to an IMS printer that caused all pending print jobs to fail has been fixed.

2879885 (1107242)
• When the last DLI call was a CHKP call, IMS incorrectly issued a COMMIT rather than a ROLLBACK

sync point during an ABEND of an IMS BMP. This has been fixed.

2877795 (1107323)
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• A problem that caused an External Security Manager to indiscriminately authorize an unprotected IMS
resource without regard to its "allow unknown resources" configuration setting has been fixed.

2877057 (1106882)
• A problem with incorrectly formatted output data appearing on IMS screens when default literals or

system literals were assigned to output message fields has been fixed.

2825068 (1100049)

Interface Mapping Toolkit

Back to the list

• A problem with Enterprise Server that caused an alphanumeric data item mapped to a SOAP Boolean
to give results that were incompatible with the mainframe for invalid data values has been fixed.

2887795 (1108360)

• The performance of a COBOL Web client has been improved when processing services with interface
parameters containing unbounded arrays.

2884760 (1108026)

• When a path specified as part of an ls2ws parameter contained at least one space, ls2ws would fail.
This has been fixed.

(622294)
• EJB generation/deployment has been enhanced to produce an EAR file. Unlike the EAR file produced

during client generation, this deploy-time EAR does not contain a WAR file and thus does not contain
any JSP files.

JCL Support

Back to the list

• Spool files with a status of 'Printing' are now correctly removed from ESMAC when housekeeping is run.

3108694 (1109666)
• An issue with the Catalog having an incorrect GDG current bias has been fixed.

3106790 (1109468)
• Specifying DD Dummy in front of the DSN now results in the same behavior as on the mainframe.

3106305 (1109425)
• A catalog listing of a dynamic PDS, where the PO is defined in a user catalog, will now return the

correct list of members.

3106260 (1109433)
• Specifying DD Dummy in front of the DSN now results in the same behavior as it does on the

Mainframe.

3104175 (1109272)
• JCL HSF - if a job step abends because a data set was not found, the resp field of the previous record

will no longer be corrupted.

3103184 (1109101)
• A new environment variable has been introduced. Set ES_JES_PARM_INIT_LOW=Y to initialize the

parameter string passed to a program executed by JCL to low-values. The default behavior
(ES_JES_PARM_INIT=N) is to initialize the string to spaces.

3100700 (1109519)
• A deadlock situation, when multiple dispositions were used for the same file, has been fixed.

3100475 (1109067)
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• MFJPTPCH now returns a condition code of 4 when it is run against an empty file.

2991029 (1108802)
• A fault in the final disposition processing of a MOD,PASS dataset has been corrected.

2990557 (1108750)
• An issue with the Catalog having the incorrect GDG current bias when concurrent jobs access the same

GDG, has been fixed.

2990054 (1108690)
• An issue where duplicate job numbers were assigned if MF_MVSJOB had a reset value of '+' has been

fixed.

2988755 (1108562)
• An enhancement to the loading of a JCL program means that, if there is a problem loading it, the run-

time system error code will be reported. The JCLCM0193U message, PROGRAM NOT FOUND -
<program name>' has been changed to 'PROGRAM NOT LOADED - <program name>. RTS CODE:
<rts code>'.

2988302 (1108519)
• MVSSPLHK now correctly removes the JESYSMSG for the last job in casspool.dat.

2886034 (1108308)
• A new option (CLEAN-DS-FROM-ACTIVE) has been introduced to the MVSSPLHK spool housekeeping

process, which prevents removal of time-expired datasets from an active job.

2885734 (1108144)
• MFFTP now correctly updates the sftp.cfg file with the port number specified in the JCL PARM.

2885618 (1108295)
• The detection of the charset of command files used by MFFTP has been improved.

2885559 (1108081)
• The failure of MFFTP to transfer an empty ESDS file from a user defined file has been corrected.

2883862 (1107878)
• The delete sweep processing of GDG has been corrected so that a new GDG dataset created in a step

is not reported as 'dataset not found' in successive steps when its older generations are deleted via
DISP=(OLD,DELETE).

2883681 (1107850)
• When using IDCAMS ALTER NEWNAME for a GDG bias, a check is performed to ensure the GDG is

defined in the catalog, and if it isn't, an error message (JCLAM0241E) is generated.

2881259 (1107477)
• The ASC2EBC and EBC2ASC modules are now included in the MFFTP module.

2880401 (1107321)
• A file not found error resulted when using a PDSM for SYSUT1 in an MFJPTPCH step. This has now

been fixed.

2879536 (1107203)
• An RTS114 error in IDAMJRM, when using MFFTP, has been corrected.

2879453 (1107607)
• An issue where duplicate job numbers were assigned if MF_MVSJOB had a reset value of '+' has been

fixed.

2875286 (1106770)
• Adding a new dataset no longer results an error in the ESMAC catalog listing (error code 9904).

2874557 (1106582)

Resolved Issues | 43



• When a JCL process was forcibly killed, an ENQ on SYSZJOBD could be left preventing other jobs of
the same name from running.

2872077 (1106506)
• Previously, setting a BLKSIZE of zero resulted in a catalog entry with a BLKSIZE set to 65535.

2871795 (1106303)
• An issue when using MFFTP to transfer a file that has consecutive CRLFs has been corrected.

2870653 (1106015)
• You no longer receive a U4038 abend when calling MFJZLPSA with a JCL that uses DFSRRC00 and

BMP.

2869477 (1105804)
• An RTS114 error in IDAMJRM, when renaming a dynamically allocated GDG bias using MFJCTLBP,

has been corrected.

2868312 (1105647)
• An issue with tracing messages from MVSSPLHK could result in receiving an RTS 114 error message.

2867854 (1106300)
• A problem that sometimes caused IEBCOMPR\MFJMATCH results to be truncated has been fixed.

2867057 (1105644)
• The catalog xml utility, mfcatxml, now supports the export and import of VSAM-SHARE-OPTS using the

GDG-EMPTY-COUNT field.

2866823 (1105394)
• Under VSE, when the environment variable ES_SAM_ESDS is set to Y, an open OUTPUT of a reusable

ESDS file resets the file in situations when the DISP is not specified in the DLBL statement.

2865599 (1105186)
• The catalog list function now returns correct results when user catalogs exist.

2865225 (1105120)
• When using the JOB KEEP option of MVSSPLHK without a duration parameter, the job was removed.

2864643 (1105034)
• The JES000915E error message now shows the correct userid.

2856571 (1103927)
• Some issues with the performance of MFJAMS LISTCAT processing have been fixed.

2809335 (1105962)
• The number of supported user catalog nodes, MFUSERCAT_NODE and MFUSERCAT_LOC, has been

increased to 64.

2805554 (1106346)
• If you have enabled 7-digit job number support via MF_MVSJOB, to revert to 5-digit support, set

MF_MVSJOB=<low number>+<high number> where high number is less than 0099999, and ensure
that the '+' sign is used to separate the low and high values.

• You can now make catalog searching and filtering more consistent with the results produced on the
mainframe by setting ES_CATLG_DISABLE_ADDITIONAL_QUAL=Y. Setting this variable to Y emulates
the effect of disabling the ‘Include Additional Qualifiers' option on the mainframe. The default setting for
ES_CATLG_DISABLE_ADDITIONAL_QUAL is N.

2883777 (1107870)
• Trying to delete a job record no longer fails with a Run-Time System error 173.

2876102 (1106778)
• ES_ESM_IGNORE_PDSM_RULE must be set to 'Y' to ensure that the access to PDS members in

ESMAC is controlled by the access privileges to the PDS itself.
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2869207 (1105872)
• The support for catalog listings using wildcards has been improved.

2860297 (1104531)
• Using the JOB field (and then Delete) to delete all SYSOUTs of a job now works as expected.

2857238 (1104017)

• Conditional execution of the MFPAUSE user exit is enabled if the PAUSE statement follows an IF
statement.

2869354 (1105809)
• DLBLs in the VSE configuration file are now allocated correctly when the JCL contains a PAUSE

statement.

2867871 (1105749)
• A problem with MFFTP that prevented the FTP of an empty ESDS file has been fixed.

2867363 (1106130)
• To prevent interference with MFFTP execution when running under VSE, edit the VSE configuration file

USE-SYSIN section for MFFTP and assign the permenant instream DD name to SYSIPT (IPTSYS).

2864865 (1105434)
• Jobname information is no longer carried forward from one VSE job to the successive jobs.

2864594 (1105072)

Mainframe Access

Back to the list

• The "$" and other national characters are now included in Endevor member filters.

3103132 (1109163)
• A z9 compatible version of MFA is available on request from your Support Engineer or Account

Manager.

2885220 (1108073)
• You no longer need to use the MFA4ENDV LRECL override table when using Endevor types with a

source length greater than 80.

2878450 (1107406)
• After an MFDAS IMPORT failed with an open error on a data set the associated file handle was not

freed. This could potentially lead to the depletion of all MFA file handles.

2878272 (1107023)
• Line sequential output is now correctly handled by the MFA file handler (Data Connect).

2878168 (1107430)
• Mainframe Access server provides a new command, UNLOCK, with the following syntax: F

MFA,UNLOCK,DSN=aaa.bbb[,MEM=mmmmmmmm] You can use this command in situations where a
user has terminated an AWM edit session which left the member lock active. To display MFA ENQs, use
IBM's TASID (option 3) application from ISPF. This application provides a much better display than the
console display.

2860316 (1104416)

• Customers using non-US code pages no longer receive errors when doing bulk member import with
mfmonmx2.

2881013 (1107577)
• The mfmon2 utility now only performs an initial download if the Micro Focus PDS does not have any

ISPF statistics.

2872024 (1106302)
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• Previously, for catalog filters specified in "mfdas cat ..." commands, the character '#' was translated to
'%', which is interpreted as match any character. Since '#' is actually a valid alphabetic character in US
EBCDIC and can be used in data set names, this behavior caused unexpected problems with catalog
services. This feature has now been deprecated.

2877352 (1107173)

Micro Focus Batch Scheduler Integration

Back to the list

• MFBSIJCL now returns the return-code 219 when the batch SEP is killed.

2881528 (1107507)
• MFBSI now writes back the Control-M %%INCLIB statement in the submitted JCL. This is to help

identify the origin of JCL statements.

2868077 (1105595)
• The MFBSI Control-M AutoEdit emulation is now ignoring the IF/ELSE statements block when the

condition is false.

2863481 (1104860)
• The default delays used by MFBSIJCL to check for a job state in Enterprise Server are as follows - two

seconds before each check for "Job Started" and ten seconds before each check for "Job Concluded". It
is now possible to configure these delays in the MFBSI configuration file, mfbsi.cfg, with the following
two new parameters - JOBSTART-LOOKUP-FREQ and JOBEND-LOOKUP-FREQ. Both parameters
accept values between 1 and 60 (in seconds), and AUTO. When AUTO is used, MFBSIJCL uses an
initial frequency of one second for three minutes after which the default values are restored. Using these
parameters will significantly reduce the overhead elapsed time in MFBSIJCL when compared to the
Enterprise Server JCL reported execution time of a job. This has an effect mainly in scenarios when you
have short-running jobs that are frequently executed.

2857416 (1105116)
• MFBSI now resolves the Control-M statements %%INCLIB and %%LIBSYM using the DSN located in a

user-defined Catalog.

Micro Focus Directory Server

Back to the list

• Fixed a memory leak in the MFDS process.

2876419 (1106799)
• A memory leak in the MFDS process occurred if non-SSL-enabled connection attempts were made

against an SSL-enabled MFDS. This has now been fixed.

2869493 (1106567)
• The MFDS -g command-line option now correctly handles the import of multiple region definitions from

a single XML file.

2840162 (1101798)
• An issue that could potentially cause heap corruption in MFDS if the configuration data for an individual

object was greater than 1K has been fixed.
• The "Renew" option available in the Enterprise Server Administration Web interface now works if SSL is

enabled.

Monitoring and Management

Back to the list

• JCL jobs that generate STEPBYPASSED events no longer cause incorrect values in JCL HSF records.

2886646 (1108200)
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• Spurious STEP BYPASSED events for dummy steps were being passed to the user exit and the HSF
exit.

2873504 (1106446)
• An issue where duplicate HSF records could be created has been fixed.

2856941 (1103977)

OLE Class Library

Back to the list

• A problem with accelerator keys being handled by an ActiveX control has been fixed.

2990224 (1108719)

OpenSSL

Back to the list

• The version of OpenSSL included in this product has been updated to version 1.0.2j.

PL/I Support

Back to the list

• MOD function now works correctly with char string arguments.

2880086 (1107327)
• Using RETURN inside a SELECT now works correctly.

2877979 (1107006)
• A problem when using SUBSTR as an argument to UPPERCASE has been fixed.

2863064 (1104802)

• A problem invoking a function call using an entry variable with the unaligned attribute (or compiled -zp1)
has been fixed.

3107510 (1109544)
• Diagnostic message 2012 has been changed as follows: Internal IL overflow. Unable to continue

processing. Try breaking the compilation unit apart into smaller modules if possible, or reducing the
number of executable statements. If this message persists, contact Micro Focus SupportLine.

3106231 (1109494)
• mfplx32 and mfplx64 will now always compile in correct mode.

3105182 (1109296)
• A problem calling a function with no arguments and a fixed decimal return type with non-zero scale has

been fixed. This problem was limited to calling the function without (), e.g., call func;

3104790 (1109255)
• A problem with restricted expression evaluation of initializers when the GLOBALDEF attribute is

specified has been fixed.

3104276 (1109288)
• A problem when passing structure arguments to structure parameter descriptors that was not of the

same shape is now properly diagnosed.

2991300 (1108810)
• Passing duplicate string literals as function parameters now works correctly when compiled using -opt.

2991006 (1108785)
• A problem when using both the compiler options -graphic and -fdmaxp has been fixed.
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2990363 (1108706)
• A problem with an assignment of a non-array structure to array of structure has been fixed.

2912429 (1108422)
• A problem diagnosing an expression used as data-list item has been corrected.

2883992 (1107886)
• Using TRIM as a parameter to another built-in function now works correctly.

2882983 (1107722)
• A problem with array structure assignment requiring conversion has been fixed.

2882731 (1107654)
• Assigning ''G to a graphic variable now works correctly.

2881762 (1107513)
• The compiler now diagnoses possibly uninitialized automatic variables at the point of first use as seen in

the source program, if not previously set by an assignment statement, or passed-by-reference as an
argument in a procedure call.

2881037 (1107420)
• ENTRY with the LIMITED attribute is now supported. Restriction: ENTRY LIMITED with STATIC INITIAL

is not currently supported (AIX only).

2881035 (1107482)
• The STRING built-in function has an implementation limitation of its result length of up to 32767 bytes.

The compiler now diagnoses this limitation for a non-variable length result with an S-level diagnostic.

2880813 (1107384)
• mfpli no longer loops endlessly when compiling some programs with the -pic option.

2878919 (1107206)
• An erroneous diagnostic citing an invalid DEFINED overlay has been corrected.

2871953 (1106212)
• An issue with GRAPHIC string comparisons has been fixed.

2869451 (1105800)
• A problem with initialization of structures containing a CHAR(0) member has been fixed.

2868923 (1105719)
• A problem with passing an unconnected array reference to an argument with CONNECTED in its

descriptor has been fixed.

2868606 (1105886)
• A new compiler option "-default connected" (or "-dft conn") applies the CONNECTED attribute to array

parameter descriptors by default. When passing arguments to parameters without an explicit
CONNECTED attribute, the compiler assumes the callee parameter to be connected. If the caller
argument is unconnected (discontinuous in memory), a dummy connected argument is created at the
call-point. The NONCONNECTED attribute when explicitly applied to parameter descriptors overrides "-
default connected".

2868606 (1106271)
• The compiler now diagnoses PICTURE specifications which cause internal compiler implementation

limits to be exceeded.

2868176 (1105602)
• A problem with GRAPHIC concatenation causing a SIGSEGV has been fixed.

2867892 (1105565)
• Repeat factors for PIC X and PIC A specifications are now allowed up to 255. The maximum total field

width of a picture specification remains at 255 bytes, now documented under Implementation Limits in
the Open PL/I User's Guide.
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2867770 (1105548)
• A problem with an ENTRY invocation without () has been fixed.

2867705 (1105540)
• A problem with a comparison of a BIT(1) to a numeric literal or FIXED BINARY variable has been fixed.

2866657 (1105363)
• A possible problem with the scoping of implicit and contextual declarations has been corrected.

2865207 (1105109)
• The diagnostic message MFPLI00176S when issued erroneously has been fixed. The text of the

diagnostic has also been corrected and changed to W-level.

2864859 (1105066)
• A problem with EBCDIC conversion of string literals under the Japanese locale has been corrected.

2859505 (1104311)
• A problem calling entry variables based on pointers has been fixed.

2840869 (1101873)
• The CHARVAL built-in is now supported.

(627778)
• The relational operator <> is now supported. It is equivalent to "Not Equals".

(625262)

• Previously, if the user had set TMP, TEMP, or MFPLI_CONFIG_DIR to a non-existent directory and
attempted to debug a JCL Jobstream using CodeWatch, the job was wrongly terminated. A new CTF
diagnostic is now generated which will allow the user to determine that they've incorrectly set the
directory to be used for temporary files.

2882313 (1108052)

• Previously, a diagnostic was issued if a macro variable was declared twice. It is now only issued if the
second or subsequent declaration has different attributes from the initial declaration.

3108673 (1109680)
• Previously, if a nested macro was invoked using a parameter that had been omitted, but which had a

value assigned in the enclosing macro, the nested macro did not receive the parameter value.

3105212 (1109323)
• Previously, the macro preprocessor issued a syntax error when a macro preprocessor variable was

declared using the SCAN or NOSCAN attributes.

3104598 (1109315)
• Previously, if the ANSWER statement was used in a PL/I Macro, the resulting output was not rescanned

for replacement prior to being driven to disk.

2887974 (1108455)
• Previously, if using the PL/I Macro Preprocessor to handle code which contained IBM's newest operator

"<>" for "Not Equal", an error message was generated. The Macro Preprocessor has been enhanced to
accept <> as not equal.

2885570 (1108085)
• A previous fix related to the use of -margins and PL/I exponentiation caused a failure when a macro

expanded and caused a comment to be pushed to straddle the right margin such that the / and * were
split. This no longer occurs.

2884503 (1107984)
• Previously, if a % preprocessor statement was on the first valid column of a line which preceded a line

which ended using all available columns and -margins was specified, then the data on the preceding
line could be erroneously omitted. This no longer occurs.
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2884467 (1107970)
• Previously, if declaring macro preprocessor arrays within a factored declaration, they were not correctly

parsed/interpreted. This has now been fixed.

2880399 (1107344)
• Previously, if using RETURN; within a PL/I Macro, it was flagged as invalid syntax. This no longer

occurs.

2880397 (1107334)
• The PL/I macro preprocessor now accepts the "_" character in hex literal constants.

2880350 (1107312)
• The macro preprocessor now supports macro procedures written with a void parameter list.

2880349 (1107311)
• Previously, the use of open and close parens within the ANSWER expression caused an incorrect result

and/or an error message. This no longer occurs.

2880347 (1107314)
• An enhancement made to support -incafter in a single macro pass broke the macro preprocessor's

ability to use macro pp built-in functions outside of a macro pp procedure. This has been fixed.

2877724 (1106992)
• Previously, the macro preprocessor did not support the LEAVE statement for exiting a DO block. It is

now supported.

2874544 (1106595)
• Previously, the macro preprocessor did not interpret a DO statement with "BY 0" as an infinite loop that

could only be terminated by a LEAVE or GOTO. This has now been fixed.

2874169 (1106508)
• Previously, the macro preprocessor required the first token in a THEN or ELSE clause of an IF

statement to be a % symbol when parsing outside of a macro procedure. This is no longer required.

(627710)
• Previously, %PROCESS statements in the code resulted in an error when the code was parsed by the

macro preprocessor. %PROCESS is now parsed/ignored.

(628209)

• Previously, a CTLASA file that was opened for output but not written to erroneously generated a
CTLASA Page Feed when closed automatically. This has now been fixed.

3105667 (1109464)
• Previously, if an AREA variable was part of a structure, and the structure was BASED, AUTOMATIC or

CONTROLLED storage then the AREA was not usable until it was initialized with the EMPTY built-in
function. Enterprise Developer now mimic IBM's behavior and automatically initialize AREA variables to
EMPTY() regardless of whether they are scalar or part of a structure.

3104275 (1109498)
• Previously, a combination of consecutive PUT SKIP() statements did not generate a series of CTLASA

characters that matched the IBM Mainframe behavior. This has now been fixed.

3101399 (1108926)
• Previously, if using PUT EDIT LINE() with non-contiguous lines, there was an error in the calculation of

the number of lines that needed to be skipped via CTLASA control characters. This has now been fixed.

2884058 (1107881)
• A problem with PUT SKIP EDIT when driven from an ON ENDPAGE has been corrected.

2882729 (1107653)
• A problem with ASA Control characters when utilizing the language feature that skips to a new page

when the specified LINE is <= to the current line has been corrected.
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2882011 (1107545)
• The MOD built-in fucntion now works correctly with fixed dec or pic variables.

2881986 (1107540)
• Previously, an unflushed stream file which contained a buffer that would cause it to match the

PAGESIZE of the file erroneously triggered ENDPAGE upon the close of the file. This no longer
happens.

2879623 (1107246)
• Previously, if using PUT PAGE; followed immediately by another PUT statement which included a PAGE

option, there were not two page ejects emitted as CTLASA characters. A secondary problem related to
using the RECSIZE() option of the ENV Attribute to establish a longer than standard LINESIZE for a
stream output file has also been corrected.

2875866 (1106719)
• An undocumented IBM behavior with regard to the generation of CTLASA control characters for the

second line of the first page of a stream I/O file has been corrected.

2873492 (1106402)
• A problem with the comparison of two PIC variables which each contained multiple consecutive drift

characters has been corrected.

2869873 (1105854)
• Previously, if reading SYSIN via a PL/I Program compiled with -ebcdic, from a physical dataset in an

enterprise server region running in EBCDIC mode, the input was garbled. This no longer occurs.

2865346 (1105128)
• Previously, if using PUT SKIP(x) where x is greater than 1, on the first line of the first page of a PRINT

CTLASA file, the use of ASA control characters did not mimic the undocumented behavior present in
IBM's PL/I on z/OS. This has now been fixed.

2864096 (1104958)
• Previously, when a CTLASA file was OPEN(ed) and CLOSE(ed) without any data being written, a zero

length file was created. Open PL/I now matches IBM's behavior and emits a single blank page feed line.

2863818 (1104911)
• Previously, if using an EXTFH.CFG where the [XFH-DEFAULT] contained INSERTNULL=OFF, the

compiler would trap when compiling larger complex programs while attempting to read back in a
temporary file created during the parsing phase. This no longer occurs.

2863220 (1105599)

• ECM now generates correct code to drive user-specified labels in exec sql whenever goto xxx;
statements.

3105039 (1109297)
• The -optsql, -optcics, -optdli, and -optexec compiler options now support strings that can be as large as

2048.

2877088 (1106913)

REX Support

Back to the list

• When running a REXX EXEC under Enterprise Server or Enterprise Server for .NET, an "Invalid
Expression" error occurred for an assignment statement where the expression being assigned to the
variable had been omitted. An empty string is now assigned to the variable if the expression is omitted.

2880655 (1107390)
• A REXX exec could fail with a S0C4 abend or an RTS 114 error if it was greater than 4096 bytes in

length and specified either as in-stream data or catalogued as an RECFM=F or RECFM=V dataset.
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2878613 (1107100)

RM/COBOL

Back to the list

• When FILETYPE(21) was specified for a LINE SEQUENTIAL print file, you could receive a Run-Time
System error "13". Writing to a printer from a Visual COBOL program through the RM File Manager
(filetype 21) now works correctly.

2874987 (1106616)

Run-Time System

Back to the list

• Adis SCREEN SECTION ACCEPT statements for PIC N DISPLAY-1 items now correctly accept DBCS
characters with a lead byte of x"87".

3104586 (1109231)
• A error when using very long command lines with Profiler (or cobprof on UNIX) has been fixed.

2884968 (625185)
• You can now double-click (to run) managed executables that use the ACUFH file handler; previously,

they may have failed with a COBRT198 error.

2880827 (1107388)
• When debugging a native Object COBOL application, the debugger no longer fails with an intermittent

COBRT114 run-time error when getting the type and value of an object's handle.

2875531 (1106808)
• A multi-threaded application that makes use of the COBOL syntax for handling mutexes, monitors,

events and semaphores, or the corresponding CBL_ APIs, no longer fails intermittently with various run-
time errors due to memory corruption.

2860205 (1104446)
• Animating a core file that has been moved to a different directory, for a core file produced by an

application compiled to executable, no longer fails with a "Program is not animatable" error. Previously, it
would on certain platforms.

2856631 (1103933)
• Detaching from animation that was started using the debug_on_error tunable could cause animation to

re-start again for the initial error - this has now been resolved.

• In managed COBOL, a CANCEL data-name statement no longer fails or crashes if the contained
program name is not space-terminated.

2887392 (1108320)
• Using user-defined class conditions in managed code no longer gives incorrect results.

2887005 (1108290)
• When executing a SQLCLR stored procedure for a second time, programs not found during the first

execution might not be found dynamically.

2879012 (1107201)
• The backtab key now works correctly when performing ADIS screen i/o operations in managed code

applications.

2877480 (1106928)
• Using the CBL_FILENAME_CONVERT library routine resulted in receiving an exception in managed

COBOL if bit 3 was set for the function parameter and CTF tracing was then enabled.

2876179 (1106763)
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• An environment variable with a value containing a leading space is no longer treated as having been
deleted.

2872919 (1106405)
• A CANCEL of a dataname containing low values no longer causes a Run-Time System error in

managed COBOL code.

2872140 (1106247)

SQL: COBSQL

Back to the list

• A problem that caused the COBSQL preprocessor to incorrectly parse comments beyond column 72
has been fixed.

3101746 (1108980)
• A problem with COBSQL producing a duplicated cursor data item when KEEPCOMP was used has

been fixed.

2874051 (1106531)
• A problem that caused the COBSQL preprocessor to incorrectly process source lines with characters in

column 73 and beyond has been fixed.

2869958 (1109899)

SQL: OpenESQL

Back to the list

• A problem that occurred when SQLCODE was set incorrectly and an EXECUTE IMMEDIATE statement
was executed multiple times has been fixed.

2990794 (1108754)
• A problem using SQL(PROCOB) and SQL(DATE=EXTERNAL) with Oracle fully managed data access

provider for .NET has been fixed.

2989291 (1108639)
• Performance when using SQL(PROCOB) with OpenESQL ADO.NET runtime and Oracle unmanaged

provider has been improved by reducing occasions where Oracle's ALL_SYNONYMS table is accessed.

2913100 (1108599)
• A problem that occurred when a stored procedure that makes dynamic COBOL CALLS executes an

EXEC SQL CLOSE <cursorName> WITH RETURN TO CALLER statement has been fixed. For this fix
to be effective, the stored procedure must not be compiled using SQL(OPTIMIZESPCURSORS).

2887060 (1108265)
• A problem fetching from a cursor defined for a stored procedure call that doesn't return a result set has

been fixed.

2885499 (1108075)
• A problem with DESCRIBE CURSOR in COBOL SQLCLR stored procedures for cursors that retrieve

result sets from nested stored procedure calls has been fixed.

2883792 (1107841)
• A problem in COBOL stored procedures that occurred when a COBOL CALL followed a cursor OPEN

for a TSQL procedure call has been fixed.

2881606 (1107529)
• For .NET applications accessing Oracle databases, character values used in numeric host variables

caused performance degradation. This has been fixed.

2877103 (1107035)
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• A problem that caused OpenESQL to incorrectly handle FETCH statements when the number of host
variables did not match the number of columns in the result set has been fixed. Host variables in excess
of result columns remain unchanged. If the number of host variables is fewer than the number of result
columns, SQLWARN 3 is set to 'W' in the SQLCA. Note: When using PostgreSQL with ODBC, you must
adjust the DSN configuration to disable updatable cursors because OpenESQL provides its own
support for updatable cursors with PostgreSQL.

2876426 (1106813)
• A COBOL stored procedure could not retrieve multiple result sets from an OpenESQL cursor via a

nested stored procedure call. This has been corrected, and the retrieval of multiple result sets from a
COBOL stored procedure is now supported.

2875262 (1106668)

• The OpenESQL preprocessor incorrectly expanded a group host variable used in a CURSOR SELECT
statement, resulting in a run-time error. The preprocessor has been modified to generate a COBES0130
error message in this case.

3104602 (1109289)
• A problem the prevented OpenEQL applications calling SQL Server stored procedures with no

parameters when using the legacy 'SQL Server' ODBC driver has been fixed. Important: We strongly
discourage use of the legacy 'SQL Server' ODBC driver. Instead, we recommend that for best
performance and functionality, use the ODBC driver that corresponds to the version of SQL Server used
by the application.

3100550 (1109071)
• A problem with HCOSS code generation that occurred when duplicating input host variable references

(for example when substr() is used with 2 rather than 3 parameters) has been fixed.

3100098 (1108819)
• A problem with the OpenESQL native routine that provides DSNTIAR emulation sometimes caused an

RTS114 error. This has been fixed.

2989595 (1108699)
• A new OpenESQL directive, GEN-SQLCA, has been added to generate the SQLCA copybook in a

program when it has not been explicitly included. This directive provides additional support when
migrating applications compiled with STDSQL(YES) on the mainframe.

2887858 (1108368)
• A problem with the MSSQL XA switch module sometimes causing a CICS transaction to abort if it

ended without closing all FORWARD and READ ONLY cursors has been fixed.

2887074 (1108340)
• An inconsistency in reporting data truncation warnings when using PostgreSQL has been fixed.

2886648 (1108201)
• OpenESQL and OCI have been updated to to prevent RTS198 errors when using DSNTIAR with

ODBC. To take advantage of this new functionality, specify the cob -d command flag to resolve
DSNTIAR with the correct callable shared object. For example, to compile a COBOL program into an
executable on a 64-bit platform with OESQL DSNTIAR: cob -x program.cbl -d
DSNTIAR@cobmfdsntiar64.so -L$COBDIR/lib -lmfpliz -lplidump -llmgr -lm Or, to compile a PL/I
program into an executable on a 32-bit platform with OESQL DSNTIAR, execute the following two
commands: mfplx -c PROGRAM.pli -sql odbc -optsql "behavior=mainframe nosmftrace" cob -x
PROGRAM.o -d DSNTIAR@cobmfdsntiar.so -L$COBDIR/lib -lmfpliz -lplidump -llmgr -lm

2884651 (1107997)
• A problem when using OpenESQL for JDBC with the "Use Dynamic Calls" project option has been

fixed.

2883500 (1107955)
• A problem with SQL(AUTOFETCH) that affected SQL Server FORWARD READ ONLY WITH HOLD

cursors performance has been fixed.
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2880840 (1107580)
• The ADO.NET Run-Time System for OpenESQL now returns the correct value in SQLERRD(3) after a

cursor fetch when other statements are executed between any fetches on the cursor.

2880814 (1107386)
• OpenESQL now allows FREE to be used as an SQL identifier. It is server dependent if this is supported

at compile time when using SQL(CHECK) and at run time.

2880673 (1107368)
• A new OpenESQL directive, CLOSE_ON_COMMIT, has been added to provide greater control over

cursor behavior on COMMIT for cursors that are not explicitly declared using WITH HOLD.

2879558 (1107305)
• A problem with HCOSS handling of nested table references in DB2 statements has been fixed and error

messages when using SQL(STRICTPARSE) have been improved.

2879503 (1107286)
• The SQLBGP COBSQL compiler directive option has been added to ensure successful background

parsing of EXEC SQL statements when the Pro*COBOL installation resides on a remote machine and
not on the local machine.

2877618 (1107292)
• A problem that prevented SQL(CHECK) from working correctly on some databases has been fixed.

2877284 (1107021)
• When used with the SQL(USER-SQLDA=MAINFRAME) directive, the OpenESQL preprocessor could

incorrectly generate ES0100 errors if a group variable was used in an EXEC SQL FETCH statement.
This has been fixed.

2876420 (1106803)
• The OpenESQL preprocessor sometimes failed to return comp data items correctly if compiled with

SQL(DIALECT=MAINFRAME). This has been fixed.

2874931 (1106606)
• The OpenESQL preprocessor has been updated to generate a more meaningful message,

COBES0129, when it encounters an undefined host variable.

2874408 (1106624)
• A problem with SQL(NORSLOCATORS) leaking SQL Server server cursors has been fixed.

2872613 (1106294)
• HCOSS handling of the DB2 CHAR() function did not always properly apply the compile-time settings of

DATE and TIME as the default formats when CHAR was called with a date or time value but no date or
time format parameter was supplied. This has been fixed.

2872518 (1106404)
• A new SQL compiler directive option, OPTIMIZECURSORS, has been added to optimize memory

consumption when using OpenESQL for ADO.NET with Oracle, DB2, or PostgreSQL. The default
setting is SQL(OPTIMIZECURSORS=YES). See the OPTIMIZECURSORS reference topic in the
documentation for complete information.

2871132 (1106056)
• Decimal and host variables with the same length are now converted to EBCDIC correctly when

CHARSET(EBCDIC) is enabled; however, if you link native COBOL applications that use display
numeric variables in SQL statements using CHARSET(EBCDIC), you might get a link error. To resolve
this issue, see the OpenESQL topic under Known Issues and Restrictions.

2857755 (1104091)
• A problem with the ODBC switch module not reporting broken connections to Enterprise Server when

xa_start() is called has been fixed.

2843672 (1108847)
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• A problem that caused the OpenESQL preprocessor to incorrectly interpret UNICODE(PORTABLE) has
been fixed.

• The SQL xa_open string has been updated to include the PACKAGEPATH option, which enables the
use of substitution markers to customize the package path based on the current JCL or CICS user
name, XA resource name, enterprise server region name, or a combination. In addition, when used with
the UserP option, the PACKAGEPATH option value changes when the user for the connection changes.

• A problem using SQL(DATEDELIM) with SQL(DATE=JIS) has been fixed.
• OpenESQL has been updated to enable execution of selected SQL statements at compile time. You can

use this functionality to create temporary tables during compilation and to enable the use of
SQL(CHECK) with temporary as well as permanent tables.

• The encoding of the sqltype fields in SQLDA has changed and any applications that use dynamic SQL
with SQLDAs might require application code change. The new sqltype encoding scheme adds 0x2000
to sqltype when an integer, a small integer or a big integer host variable is COMP and 0x1000 and when
any indicator host variable is COMP. Otherwise, COMP-5 is assumed for indicators and for integer,
small integer and big integer host variables.

SQL Option for DB2

Back to the list

• A problem with the Declaration Generator that prevented COBOL copybooks from being generated
correctly for tables with timestamps and XML columns has been fixed.

2875742 (1106868)

• The XDB preprocessor has been updated to support source connect files that previously generated a
"File not found" error for EXEC SQL INCLUDE statements located on the source connect drive.

2912819 (1108471)
• The XDB ECM has been enhanced to handle temporal table query syntax.

2876438 (1106807)

• Implemented the JDBC ResultSet Interface getBigDecimal methods that do not require a scale
argument: getBigDecimal(int columnIndex) and getBigDecimal(String columnLabel).

2877817 (1106963)

• A problem that caused an X020 syntax error on SELECT DISTINCT (TRIM)has been fixed.

3105393 (1109324)
• A problem that prevented the XDB engines to successfully process a COUNT(DISTINCT expression)

scalar function when the expression was a concatenated expression enclosed in parentheses has been
fixed.

2884227 (1107903)
• A problem that caused a thread stack overflow on scalar function recursions that use CONCAT has

been fixed.

2884046 (1107882)
• A problem with the XUTLB LOAD grammar prevented the reserved word DATE from being used as a

table name. This has been fixed.

2882727 (1107652)
• An problem when correlating a subquery produced a PDMP242 error. This has been resolved.

2880672 (1107367)
• A problem that caused a FETCH FIRST clause in a scalar subquery to be ignored has been fixed.

2880671 (1107366)
• A problem using the reserved word DOCUMENT as an identifier in the first argument of a scalar

function has been fixed.
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2874154 (1106483)
• CAST AS TIMESTAMP using the special character 'T' as the date/time delimiter was not allowed. This

is now allowed.

2874153 (1106484)
• An issue with the ordering of a result set caused the incorrect row to be returned on a FETCH FIRST

ONLY clause. This has been fixed.

2873390 (1106435)
• An issue with index optimization of LIKE predicate processing has been resolved.

2873389 (1106391)
• A problem that sometimes caused the XDB Server to shut down before completing location checkpoint

operations by maintenance threads has been resolved.

2847090 (1102750)
• An problem with LIKE predicate index query optimization that caused missing result set rows has been

fixed.

2841168 (1101910)
• A problem that prevented the restoration of LOB data from a record with an LOB column after deleting

the record and then rolling back from a Save Point has been fixed.
• XDBMONN has been updated to issue the correct error message when it is started, but the server is

not running.

• The server Name be displayed in the status bar of the XDB SQL Wizard.

2865763 (1105197)
• Using ALLOW EDITING on an SQLWizard result set could result in the query being corrupted. This has

now been fixed.

2865336 (1105171)
• The restriction that prevented the editing of result sets generated from alias tables has been removed.

2857585 (1104067)
• When the SQLWizard is invoked by MFA Drag & Drop to import unload data to a table it no longer

returns an X352/X95 error.

XML Support

Back to the list

• XMLPARSE no longer returns -19 in XMLSS mode.

2913116 (1108661)
• Opened XML files are now closed when the COBOL program called by JCL is terminated.

2885450 (1108132)
• A new directive "OUTENC(INPUT)" is created to ensure encoding of the output text will be the same as

the input encoding specified in the XML declaration.

2870879 (1106332)
• XMLIO now handles REDEFINE data items correctly.

2795744 (1096302)
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Other Issues Resolved in This Release
The numbers listed are the Support Incident Numbers followed by the Reported Problem Incident (RPI)
number (in parentheses).

• 2884374 (1107928)
• 2875256 (1106645)
• 2871954 (1106649)
• 3103304 (1109198)
• 2857117 (1106716)
• 3106240 (1109462)
• 2989573 (1108689)
• 2874306 (1106666)
• 2848671 (1102872)
• 2878662 (1107084)
• 2864100 (1104959)
• 3101450 (1108990)
• 2884755 (1107973)
• 2884754 (1108098)
• 2883962 (1108118)
• 2883962 (1108119)
• 2878826 (1107101)
• 2878227 (1107012)
• 2877589 (1106938)
• 2875248 (1106679)
• 2874812 (1106627)
• 2874077 (1106516)
• 2872027 (1106210)
• 2869739 (1105894)
• 2868086 (1105954)
• 2864170 (1105040)
• 2864164 (1105035)
• 2990780 (1108760)
• 2884757 (1108096)
• 2883769 (1107830)
• 2851153 (1103313)
• 3101883 (1108971)
• 3101148 (1108902)
• 2885725 (1108103)
• 2884537 (1107964)
• 2878485 (1107076)
• 2876638 (1107036)
• 2872931 (1106328)
• 2872035 (1106199)
• 2867270 (1106437)
• 2837526 (1104757)
• 3101467 (1109005)
• 2879947 (1107389)
• 2879908 (1107247)
• 2878412 (1107371)
• 2852872 (1107046)

• 2989831 (1108862)
• 2875722 (1106767)
• 2875245 (1106642)
• 2858289 (1104218)
• 2839585 (1102006)
• 2869862 (1105851)
• 2857086 (1104025)
• 2831639 (1100766)
• 3102063 (1108996)
• 3101684 (1108956)
• 2884727 (1108008)
• 2881493 (1107488)
• 2860914 (1104582)
• 3105709 (1109380)
• 3105708 (1109382)
• 3105707 (1109383)
• 3105704 (1109377)
• 3105703 (1109374)
• 3105221 (1109372)
• 3105219 (1109379)
• 3105218 (1109371)
• 3105217 (1109375)
• 3105217 (1109376)
• 3105216 (1109370)
• 3105215 (1109368)
• 3105214 (1109369)
• 3104634 (1109245)
• 3103928 (1109267)
• 3103824 (1109284)
• 3102104 (1109041)
• 3101976 (1109010)
• 3101690 (1109039)
• 3101030 (1108911)
• 3101028 (1108930)
• 3101027 (1108932)
• 3100325 (1108856)
• 2988233 (1108531)
• 2912393 (1108452)
• 2912391 (1108451)
• 2912389 (1108442)
• 2912387 (1108439)
• 2912355 (1108501)
• 2912354 (1108450)
• 2887976 (1108736)
• 2887970 (1108418)
• 2887419 (1108331)
• 2886979 (1108286)

• 2879488 (1107196)
• 2877587 (1106984)
• 2877474 (1106937)
• 2877189 (1106921)
• 2874594 (1106590)
• 2874591 (1106575)
• 2874313 (1106592)
• 2873877 (1106610)
• 2872737 (1106316)
• 2872474 (1106964)
• 2871631 (1106297)
• 2869907 (1106670)
• 2869898 (1106147)
• 2869892 (1105900)
• 2869763 (1105896)
• 2864092 (1106070)
• 2852872 (1103790)
• 2852872 (1106311)
• 2852872 (1107278)
• 2799183 (1096680)
• 2991138 (1109121)
• 2875556 (1106727)
• 2873522 (1106485)
• 3101858 (1109029)
• 2883840 (1107954)
• 2882062 (1107704)
• 2871525 (1106466)
• 3106697 (1109529)
• 3109683 (1109781)
• 2871797 (1106201)
• 2816310 (1104173)
• 3100167 (1108936)
• 2989831 (1108879)
• 2796532 (1096369)
• 3105586 (1109338)
• 3105375 (1109313)
• 3102818 (1109347)
• 2875983 (1106861)
• 2875103 (1106822)
• 2988894 (1108994)
• 2870824 (1106018)
• 2875885 (1106721)
• 2886300 (1108160)
• 2883994 (1108116)
• 2876768 (1106926)
• 2875396 (1106686)
• 2887853 (1108380)

• 2881573 (1107673)
• 2878429 (1107279)
• 2876370 (1107219)
• 2871569 (1106143)
• 2867842 (1105600)
• 2867117 (1105493)
• 2853200 (1103409)
• 2885043 (1108044)
• 2876773 (1106847)
• 2869095 (1105803)
• 2865595 (1105786)
• 2860304 (1104472)
• 2883686 (1107844)
• 2865350 (1105129)
• 2864599 (1105025)
• 2873863 (1106487)
• 2870740 (1106000)
• 2866084 (1105259)
• 2864758 (1105772)
• 2989939 (1108666)
• 2878067 (1106990)
• 2877643 (1107028)
• 2873883 (1106635)
• 2819070 (1099603)
• 2657473 (1090356)
• 2869213 (1105788)
• 3103252 (1109178)
• 3103241 (1109176)
• 2991312 (1108795)
• 2887454 (1108358)
• 2882453 (1107614)
• 3100079 (1108823)
• 2887733 (1108399)
• 2880976 (1107464)
• 2877232 (1106950)
• 3102272 (1109059)
• 3101639 (1109086)
• 2886684 (1108370)
• 2884612 (1108024)
• 2879358 (1107190)
• 2878631 (1107110)
• 2877721 (1106966)
• 2876808 (1106856)
• 2876719 (1106845)
• 2875613 (1106730)
• 2873607 (1106420)
• 2873447 (1106429)
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• 2851640 (1103228)
• 2603382 (1087028)
• 2871769 (1106474)
• 2876285 (1106842)
• 3107224 (1109628)
• 2880556 (1107803)
• 2879876 (1107263)
• 2880593 (1107378)
• 3105620 (1109342)
• 2991280 (1108799)
• 2882386 (1107606)
• 2881902 (1107890)
• 2879176 (1107150)

• 2885859 (1108130)
• 2885529 (1108083)
• 2884236 (1108000)
• 2883551 (1107800)
• 2881659 (1107500)
• 2881243 (1107455)
• 2881040 (1107414)
• 2881038 (1107416)
• 2881037 (1107419)
• 2881036 (1107423)
• 2880647 (1107399)
• 2879819 (1107333)

• 2883907 (1107872)
• 2874406 (1106565)
• 2873249 (1106552)
• 2871661 (1106145)
• 2863482 (1104862)
• 2848848 (1102895)
• 2866216 (1105926)
• 2883667 (1107815)
• 2880475 (1107343)
• 2871842 (1106178)
• 3102432 (1109463)
• 2887808 (1108624)

• 2873158 (1106378)
• 2873035 (1106735)
• 2871178 (1106125)
• 2870557 (1106194)
• 2865051 (1105317)
• 2859144 (1104286)
• 2146936 (1059549)
• 2876653 (1106832)
• 2865001 (1105155)
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Unsupported Functionality
The following features or functionality are no longer supported:

• The HOSTSIGNS Compiler directive is no longer supported. Micro Focus recommends that you use the
following Compiler directives instead: SIGN-FIXUP, HOST-NUMMOVE, and HOST-NUMCOMPARE.
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Installation

Before Installing

Downloading the Product
You can download Enterprise Developer from the Product Updates section of the Micro Focus SupportLine
Web site.

On Windows

System Requirements

Hardware Requirements

Enterprise Developer has the following requirements in addition to the requirements of Microsoft Visual
Studio. See the Visual Studio documentation for details of the Microsoft requirements.

In general, most modern machines will have the required processor and available RAM to run the Micro
Focus products under Windows effectively. For planning purposes, you should consider having a minimum
of 2GB of RAM.

The maximum disk space requirements are, approximately:

Enterprise Developer Sentinel RMS License Manager

2.3Gb 75MB

• This includes the space needed to cache information locally so that you can modify the installation
without the original source media.

• The disk space requirements include the versions of JRE and .NET Framework supplied with the setup
file.

Operating Systems Supported

For a list of the supported operating systems, check the Product Availability section on the Micro Focus
SupportLine Web site: http://supportline.microfocus.com/prodavail.aspx.

Note:

• You can produce both 32-bit or 64-bit applications with Enterprise Developer installed on a 64-bit
operating system.

• This product can be installed on earlier versions of Windows but it has not been tested on them.

Software Requirements

The setup file will check your machine for whether the prerequisite software is installed and will install any
missing prerequisites and the product components. A supported version of Microsoft's Visual Studio 2015
or 2017 must, however, be installed in advance.
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Note:

• Besides the software listed below, the setup file also installs the 64-bit Java 8 Update 102.
• This product includes OpenSSL version 1.0.2j.

Visual Studio IDE

You must have Microsoft's Visual Studio installed in advance.

You need one of the advanced versions of Visual Studio listed below or the Visual Studio Integrated Shell
(only supported by Enterprise Developer for Visual Studio 2012 or 2013):

Professional, Premium, or Ultimate (for Visual Studio 2012)
Professional, Premium, Ultimate or Community Edition (for Visual Studio 2013)
Professional, Enterprise or Community Edition (for Visual Studio 2015)
Professional, Enterprise or Community Edition (for Visual Studio 2017) - see the next section for the
Visual Studio components you must install.

Microsoft's Visual Studio Express Edition is not supported.

If there is no Visual Studio installed on your machine, the setup file for Enterprise Developer for Visual
Studio 2012 or 2013 will install the Visual Studio Integrated Shell. Alternatively, you can download the
Visual Studio Integrated Shell from the Microsoft Download Center and install it before you install
Enterprise Developer. If you choose to install the Shell, ensure you run the installer to complete the
installation - run vsintshell.enu.exe from the location where you installed the download.

Note that some Visual Studio features might not be available with the Shell. This includes WCF or the
Visual Studio 2013 Connected IDE experience in the Visual Studio 2013 Shell - the help for more details.

Important:

• A problem with Microsoft's Windows 10 prevents installing the Visual Studio 2013 Shell on that
version of the OS. You must install an advanced edition of Visual Studio 2013 on Windows 10
before you start the installation of Enterprise Developer for Visual Studio 2013.

• Enterprise Developer for Visual Studio 2015 does not support Visual Studio 2015 Shell as the
Shell has a number of restrictions to COBOL development. The Visual Studio 2015 Shell is not
included in the setup for Enterprise Developer for Visual Studio 2015 and before you start the
installation, ensure that there is an advanced edition of Visual Studio 2015 installed on your
machine.

• On Windows 8.1 RT, Windows 8.1 or Windows Server 2012 R2, you must have the Windows
update KB 2919355 before you install Visual Studio 2015. Download KB 2919355 from the 
Microsoft Download Center.

• When installing Visual Studio 2017, ensure you select the Help Viewer component for installing to
ensure you can view the Enterprise Developer product help inside Visual Studio. When you select
components to install in the Visual Studio installer, click Individual components and check Help
Viewer in the Code tools section.

• Code generation issues in Microsoft's 64-bit JIT (just-in-time) compiler delivered as part of .NET
Framework version 4.6 can result in incorrect execution of some COBOL code compiled to .NET.
Version 4.6 of the .NET Framework is currently shipped as default with Visual Studio 2015 and
Microsoft's Windows 10. The problems include incorrect execution of MOVE and STRING
statements applied to alphanumeric operands, and incorrect execution of the ROUNDED phrase
for arithmetic statements.

Some of these issues only seem to be reproducible in COBOL language applications compiled
to .NET and some can be reproduced in other languages (C# or Visual Basic).

These problems have been reported and acknowledged by Microsoft and it is our belief that they
either have resolutions or are working on fixes for all of them. For further information about these
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issues and guidelines on how to disable the latest version of the 64-bit JIT compiler, see RyuJIT
Bug Advisory and Troubleshooting RyuJIT.

As of October 2015, Microsoft have released the following updates that address these issues with
the .NET Framework 4.6:

• Hotfix rollup 3088955 for the .NET Framework 4.6 on Windows Server 2012 and Windows 8 -
see: http://www.microfocus.com/docs/links.asp?vc=mskb3088955.

• Hotfix rollup 3088956 for the .NET Framework 4.6 on Windows Server 2012 R2 and Windows
8.1 - see: http://www.microfocus.com/docs/links.asp?vc=mskb3088956

• Hotfix rollup 3088957 for the .NET Framework 4.6 on Windows 7 SP1, Windows Server 2008
SP2, Windows Server 2008 R2 SP1, and Windows Vista SP2 - see: http://
www.microfocus.com/docs/links.asp?vc=mskb3088957.

• Cumulative update 3093266 for Windows 10: September 30, 2015 (available through Windows
Update) - see: http://www.microfocus.com/docs/links.asp?vc=mskb3093266.

The following software is also required:

• Microsoft Windows SDK is required if you are using the Visual Studio Shell. See the Microsoft
Download Center and search for Windows SDK.

• Microsoft .NET Framework 4.5. This is included with Visual Studio 2012.
• Microsoft .NET Framework 4.5.1. This is included with Visual Studio 2013.
• Microsoft .NET Framework 4.6. This is included with Visual Studio 2015.
• Microsoft .NET Framework 4.6.2. This is included with Visual Studio 2017.

Selecting the Visual Studio 2017 components to install

The Visual Studio 2017 installer enables you to customize and only install the workloads and components
that are most suitable for your area of development. For example, you can select the components that are
required for .NET desktop development, ASP.NET Web or C++ development.

The Help Viewer component is not installed by default and must be selected before you start the Visual
Studio installation to ensure you can view the Enterprise Developer product help.

If not already installed, the Enterprise Developer setup file will install the following components:

• .NET Framework version 4.6.2
• Debugger
• Visual Studio's Help Viewer
• Data services

A number of workloads and components are optional - for example, Azure, WCF, Web, WPF or SQL CLR
application development. If you require any of these, you can select them when you start the Visual Studio
2017 installer or, enable them after completing the installation - see the next section.

Installing Visual Studio 2017 features that are not currently installed

If a feature of Visual Studio 2017 was not installed during the Visual Studio installation, the respective
functionality or the project templates for it are not available. You can install a missing feature in one of the
following ways:

Rerun the Visual Studio installer:

1. Start the Visual Studio 2017 installer and choose to modify an existing Visual Studio instance.
2. Select the workloads and the components that are missing (for example, ASP.NET and web

development or Help Viewer).
3. Start the Visual Studio installation.

Use the Quick Launch control in Visual Studio 2017:
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1. Start Visual Studio 2017.
2. Type the name of the feature in the Quick Launch control - for example, type ASP.NET or Help

Viewer.

A drop-down list with any features matching your search string appears. If the feature is not already
installed, one of the search results will be an option to install it.

Use the Install Missing Feature(s) command in Visual Studio 2017:

1. Start Visual Studio 2017.
2. Click Help > Micro Focus Product Help > Install Missing Feature(s) > Feature Name.

Follow the instructions in the installer to install the missing feature.
3. Alternatively, if a Micro Focus project template requires a Visual Studio feature which is not currently

installed, the IDE displays an information bar with instructions to install the feature.

Internet Explorer 10

Internet Explorer 10 (IE 10) is required by the installation of Visual Studio 2013. If you are installing
Enterprise Developer on a machine that has no Visual Studio 2013 installed, the setup file installs Visual
Studio 2013 Shell provided that IE 10 is installed beforehand. You can download IE 10 from Microsoft's
Web site.

IIS Express

IIS Express is required if you want to use the Web development tools. You can download IIS Express from
the Microsoft Download Center.

Other Requirements

Important: This release requires version 10000.2.990 or later of the Micro Focus License
Administration tool. For local servers, you do not need to install it separately, as the setup file installs
a new Enterprise Developer client and a new licensing server on the same machine.

If you have a network server, you must update the license server before installing the product as the
client is not able to communicate with license servers of versions older than 10000.2.660. On
Windows, you can check the version of your license server by clicking Help > About in the Micro
Focus License Administration tool.

You can download the new version of the license server software from the Micro Focus SupportLine
Web site: http://supportline.microfocus.com.

Additional Software Requirements on Windows

To ensure full functionality for some Enterprise Developer features, you might be required to obtain and
install additional third-party software in addition to the prerequisite software installed automatically by the
Enterprise Developer setup file.

See this information in the Micro Focus Infocenter, in the product help for Enterprise Developer for Visual
Studio 2012 (click here), Enterprise Developer for Visual Studio 2013 (click here), Enterprise Developer for
Visual Studio 2015 (click here and Enterprise Developer for Visual Studio 2017 (click here).

Product Co-Existence
• Enterprise Developer and Enterprise Server (or Enterprise Test Server) cannot coexist on the same

machine.
• Visual COBOL and Enterprise Developer cannot coexist on the same machine regardless of which IDE

(Visual Studio or Eclipse) you install.
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Installation Restrictions and Requirements
Before starting the installation you should consider the following:

• If, when you install Enterprise Developer for Visual Studio 2012 or 2013, the machine does not have
Microsoft Visual C++ 2012 Redistributable Runtime already installed, it is installed as required by
Enterprise Developer. The installation of Microsoft Visual C++ Redistributable Runtime adds a number
of .dll files, without digital signatures, into the winsxs directory.

• If, when you install Enterprise Developer for Visual Studio 2015, the machine does not have Microsoft
Visual C++ 2013 Redistributable Runtime already installed, it is installed as required by Enterprise
Developer. The installation of Microsoft Visual C++ Redistributable Runtime adds a number of .dll
files, without digital signatures, into the winsxs directory.

• You need to be logged in with a user-ID that has write access to the registry structure under
HKEY_LOCAL_MACHINE, HKEY_CLASSES_ROOT, and HKEY_CURRENT_USER so the installation
software can set the environment appropriately. You also need to be logged on with Administrator
privileges.

On UNIX

Hardware Requirements
The disk space requirements for Micro Focus Enterprise Developer Unix Components are approximately:

Platform Installer type Setup

file size

Disk space

required for

the installation

Disk space

required for

running

the product

Sentinel RMS

license
server

POWER
running AIX

Micro Focus 513 MB 2.05 GB 1.03 GB 35 MB

HP IA Micro Focus 909 MB 3.64 GB 1.82 GB 66 MB

System Z
running Red
Hat Linux

Micro Focus 409 MB 1.64 GB 818 MB 34 MB

x86-64
running Red
Hat Linux

Micro Focus 512 MB 2.05 GB 1.02 GB 44 MB

ppc64le
running Red
Hat Linux

Micro Focus 301 MB 1.20 GB 602 MB 1 MB

SPARC
running
Solaris

Micro Focus 519 MB 2.08 GB 1.04 GB 38 MB

System Z
running SUSE
SLES

Micro Focus 271 MB 1.08 GB 542 MB 1 MB

x86-64
running SUSE
SLES

Micro Focus 519 MB 2.08 GB 1.04 GB 44

ppc64le
running SUSE
SLES

Micro Focus 271 MB 1.08 GB 542 MB 1 MB
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Operating Systems Supported
For a list of the supported operating systems, check the Product Availability section on the Micro Focus
SupportLine Web site: http://supportline.microfocus.com/prodavail.aspx.

Software Requirements for Micro Focus Enterprise Developer Unix
Components
These are the software requirements for Micro Focus Enterprise Developer Unix Components:

• The pax archiving utility is required by the setup file. Pax is distributed with most UNIX/Linux systems
but, if it is missing, you must install it separately. To verify pax is installed, run pax --help or pax --
version at the command line.

• Required libraries for Red Hat and SUSE Linux platforms - The installer checks that both the 32-bit and
64-bit libraries listed below are installed on both 32-bit and on 64-bit Operating Systems for this product
to install and work correctly.

If installing on a 64-bit OS, the 32-bit libraries are not installed by default and must be installed before
you start the installation.

Library 32-bit
Library
Name

64-bit
Library
Name

Platform

s390 SUSE 11 SUSE 12 Red Hat 6.x Red Hat 7

glibc glibc-*.i686 glibc-
*.x86_64

glibc-
*.s390

X X

libgcc libgcc-
*.i686

libgcc-
*.x86_64

libgcc-
*.s390

X X

libstdc++ libstdc++-
*.i686

libstdc++-
*.x86_64

libstdc++-
*.s390

X X

glibc-locale glibc-
locale-32bit

glibc-
locale-2

X X

glibc-devel glibc-devel-
*.i686

glibc-devel-
*.x86_64

glibc-devel-
*.s390

X X

elfutils-
libelf

elfutils-
libelf.i386
or elfutils-
libelf.i686

elfutils-
libelf.x86-6
4

N/A X X

libelf-devel elfutils-
devel.i386
or elfutils-
devel.i686

elfutils-
devel.x86-6
4

N/A X X

libelf-devel libelf-
devel-32bit-
0.137-8.19

libelf-
devel-0.137
-8.19

N/A X X

libelf1 libelf1-32bit
-0.137-8.19

libelf1-0.13
7-8.19

N/A X X

* Additional libraries required to use the core_on_error runtime variable. The gdb packages (for the
GNU Project Debugger) can be installed from the install media for your OS.

** Operating system libraries required for PL/I support on both SUSE and Red Hat.

Visit the Red Hat Web site for more information.

• Xterm, the terminal emulator for the X Window System, is part of your UNIX/Linux distribution but is not
installed by default. Use your UNIX/Linux installation media to install it.
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• Oracle's Java Platform (64-bit) version 1.8.92 or above is required. Java 7 and 8 (32 or 64-bit versions)
are supported for executing JVM COBOL code and for native COBOL and Java interoperability. You can
download Oracle's Java EE from Oracle's Web site and install it anywhere on your machine.

Note:

• On AIX and zLinux, you need to have IBM's JDK. The earliest supported release of IBM's JDK
is 7.0 Service Refresh 8. You can get IBM's AIX JDK from IBM's Web site.

• On HP-UX, you need to have HP-UX JDK. The earliest supported release of HP-UX is JDK
7.0.11. You can get the HP-UX Java JDK from HP's Web site.

To execute JVM COBOL code, you need to set the environment as follows:

• You need to set the JAVA_HOME environment variable. When installing the product, set this variable
to a 64-bit Java installation or the installation terminates. For example, execute the following:

JAVA_HOME=java_install_dir

where java_install_dir is the path to the JAVA installation directory such as /usr/java/javan.n
• You need to add $JAVA_HOME/bin to your system PATH variable. To do this, execute:

export PATH=$JAVA_HOME/bin:$PATH

• You need to set the LANG environment variable to pick up localized messages. The LANG settings
are English and Japanese only.

• GNOME menus and buttons have been standardized across all applications so that icons are not
displayed by default. To keep the icons and the look and feel of previous versions, enable the
menus_have_icons property with the command:

gconftool-2 --type boolean --set /desktop/gnome/interface/menus_have_icons 
true

Additional Software Requirements for Micro Focus Enterprise
Developer Unix Components
To ensure full functionality for some Enterprise Developer features, you might be required to obtain and
install additional third-party software in addition to the prerequisite software installed automatically by the
Enterprise Developer setup file.

See this information in the Micro Focus Infocenter, in the product help for Enterprise Developer for Visual
Studio 2012 (click here), Enterprise Developer for Visual Studio 2013 (click here), and Enterprise
Developer for Visual Studio 2015 (click here).

UNIX and Linux Installer Issues

Installing while using AFS/Kerberos authentication

If you are using AFS/Kerberos authentication to log onto your Linux system then you need to ensure you
have a local user ID which SOA and Enterprise Developer components of the product can use. This user
ID must be set up prior to running the installer. When running the installer you need to specify -
EDadminID=[User ID] on the command line so it is used by the installer.

License Server

You need to configure the computer hostname to ensure the license server will start properly.

To avoid performance issues, "localhost" and the computer hostname must not both be mapped to IP
address 127.0.0.1. You should only map "localhost" to IP address 127.0.0.1.

The following is an example of how to specify these entries correctly in the /etc/hosts file:

127.0.0.1 localhost.localdomain localhost
IP machinelonghostname machineshorthostname
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where IP is the unique IP address of the computer in xx.xx.xx.xx format.

Basic Installation
The instructions in this section apply when you are performing a basic installation of this product for the
first time. If you are an administrator, you can perform a basic installation on a local machine before
performing a more advanced installation when rolling out the product to developers within your
organization.

For considerations when installing this product as an upgrade, for additional installation options or non-
default installations and for installing the mainframe components, see Advanced Installation Tasks in your
product Help.

Installing
Note:

• This version of the product is a full install.
• See Before Installing first for important information. Also, see Installing as an Upgrade, if you have

an earlier version of Enterprise Developer installed on your machine.

To install this product:

1. Run the edvs2012_30.exe file (or either edvs2013_30.exe, edvs2013_30.exe, or
edvs2015_30.exe) and follow the wizard instructions to install the prerequisite software and the
product.

The installer installs Enterprise Developer, Enterprise Server for .NET, and offers to install Micro Focus
Rumba. The setup file will also install any missing prerequisite software as listed in the topic Software
Requirements.

Note:

• When the installation has completed, on some editions of Windows you might receive a notification
that Visual Studio 2012 has compatibility issues. This is a known Microsoft issue. To resolve it,
follow the instructions in the notification for obtaining help online, or download the KB2781514
update for Visual Studio 2012 from the Microsoft Download Center.

• If you are installing onto a machine that has an existing Micro Focus product that uses an older
Sentinel RMS License Manager, you might be prompted to remove it and install the Micro Focus
License Administration. By doing this you maintain the existing Sentinel RMS license files while
adding the Micro Focus License Administration. If you are unsure about existing licenses on your
computer or removing the Sentinel RMS License Manager, consult your System Administrator. If
you want to proceed, remove Sentinel RMS License Manager by using Program and Features
(Windows Vista or later), and rerun the installation file.

• Trial licenses cannot be used with remote desktop services. If you want to use your product in this
way, please contact Micro Focus SupportLine to obtain a relevant license.

• We recommend that you install any updates for Visual Studio and the .NET Framework that are
available at the Microsoft Download site.

• If you install JDK you might be prompted to install the latest update. The latest update is not
required for use with Enterprise Developer but you can install it if you wish.
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Installing Micro Focus Enterprise Developer Unix
Components

Note: Micro Focus offers two types of installers on UNIX and Linux - a proprietary Micro Focus
installer for installing on UNIX and Linux and a standard RPM (RPM Package Manager) installer for
installing on Linux. See your product Help for instructions on how to use the RPM installer.

These are the steps to install this product using the Micro Focus installer:

1. Give execute permissions to the setup file:

chmod +x setup_entdev_3.0_platform

2. Run the installer from the Process User ID login:

./setup_entdev_3.0_platform

When the installer starts it will prompt you to enter the superuser password so it can perform operations
that require root permissions.

The COBOL environment is installed by default into /opt/microfocus/EnterpriseDeveloper,
(COBDIR).

SafeNet Sentinel considerations

• The installation of this product could affect the SafeNet Sentinel licensed components running on your
machine. During installation licensing is shutdown to allow files to be updated. To ensure the processes
running on your machine are not affected, you need to use the -skipsafenet option, which skips the
installation of SafeNet:

./setup_entdev_3.0_platform -skipsafenet

• To protect the SafeNet Sentinel installation from accidental updating you can create an empty file
named SKIP_SAFENET_INSTALL in /var/microfocuslicensing/ as follows:

touch /var/microfocuslicensing/SKIP_SAFENET_INSTALL

While the file is present, the SafeNet installer does not make changes to the installation or shutdown the
running license daemons. If licensing needs to be updated later, remove the file and install Sentinel
RMS server manually.

Note:

During the installation process, the installer configures the product's Enterprise Server System
Administrator Process User ID. The Process User ID will be the owner of all Enterprise Server
processes except the one for the Micro Focus Directory Server (MFDS). The Directory Server process
(Enterprise Server Administration) runs as root as this allows it to access the system files and ports.

All Enterprise Server processes you start from Enterprise Server Administration run under the
Process User ID which can affects the file access and creation.

By default, the installer uses the login id of the user that runs the installer for the Process User ID. To
change the user id after you complete the installation, execute $COBDIR/bin/casperm.sh.

Advanced Installation Tasks
This section includes instructions about how to perform a non-default installation, install this product as an
upgrade, or about how to install the additional components.

The advanced installation tasks include:

• Installing as an Upgrade - included in these Release Notes
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• Command line installation options - included in these Release Notes
• Installing and licensing Micro Focus Rumba - available in the product Help and in the Micro Focus

Infocenter
• Installing the Mainframe Components - available in the product Help and in the Micro Focus Infocenter
• Installing on Microsoft Terminal Server and Citrix - available in the product Help and in the Micro Focus

Infocenter

See this information in the Micro Focus Infocenter, in the product help for Enterprise Developer for Visual
Studio 2012 (click here), Enterprise Developer for Visual Studio 2013 (click here), Enterprise Developer for
Visual Studio 2015 (click here), and Enterprise Developer for Visual Studio 2017 (click here).

On Windows

Installing as an Upgrade
Installing this release as an upgrade will automatically uninstall any HotFixes of the older version of the
product you have installed on your machine.

• Before installing this release as an upgrade, ensure you create a back-up of your Enterprise Server
configuration. To do this, on the Enterprise Server Administration home page, click Export and then
select Export Enterprise Server configuration and Security Manager definitions. This creates a
backup folder in the c:\programdata\micro focus\Enterprise Developer\MFDS. You can
restore the Enterprise Server configuration after installing this release - click Import on the Enterprise
Server Administration home page.

Enterprise Developer Installation Options
To install Enterprise Developer you run edvs2012_30.exe which contains a number of product .msi files
(Windows Installer packages). When run, edvs2012_30.exe performs some initial system checks then
sequentially installs the .msi files.

Note: The following applies to edvs2012_30.exe when installing the product for Visual Studio 2012.
The following applies to edvs2013_30.exe when installing the product for Visual Studio 2013. The
following applies to edvs2015_30.exe when installing the product for Visual Studio 2015.

edvs2012_30.exe can take a number of parameters, enabling you to specify a number of different types
of installation:

• Standard Installation

Format:
edvs2012_30.exe

Summary:
Full installation including License Manager and Enterprise Developer. During installation you can
specify options including the location to which the components are installed.

• Non-interactive Installation

Format:
edvs2012_30.exe /passive

Summary:
Full installation, but the components are installed non-interactively using default options and
directories.

• Silent Installation

Format:
edvs2012_30.exe /q
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Summary:
Full installation, but the components are installed non-interactively with no user interface, using
default options and directories.

• Modified Silent Installation

Format:
edvs2012_30.exe /q InstallFolder=d:\otherdirectory

Summary:
Full installation, but the components are installed non-interactively with no user interface, and
Enterprise Developer is installed to d:\otherdirectory.

Format:
edvs2012_30.exe /q RumbaCheckbox=1

Summary:
Full installation of Enterprise Developer and of the Micro Focus Rumba component. All components
are installed non-interactively with no user interface.

To see what parameters you can use, execute the following from the command line:
edvs2012_30.exe /?.

Note:

• Log files that are created during installation are saved in the folder specified by the TEMP
environment variable. To change the location or name of the files, use the /log parameter on your
setup command line and specify the path and file name, for example: filename /log d:\temp
\log.txt. This creates a log file, named log.txt, in the d:\temp directory.

Installing Enterprise Developer into Several Editions of Visual Studio
2017
Visual Studio 2017 is offered in different editions, Professional, Enterprise or Community Edition, that can
all co-exist on the same machine. When you install Enterprise Developer, its setup file installs it into any
edition of Visual Studio 2017 installed on the machine.

If, after Enterprise Developer is installed, you install a different edition of Visual Studio 2017, you can use
the MFVSIXINSTALL utility (available in the Enterprise Developer installation directory) to plug Enterprise
Developer into that edition.

To install Enterprise Developer in all editions of Visual Studio 2017:

1. Locate MFVSIXInstall.exe in %ProgramFiles(x86)%\Micro Focus\Enterprise
Developer\vsix.

2. Run MFVSIXInstall.exe.

This starts the VSIX Installer utility that will install all the required components into the existing editions
of Visual Studio 2017.

3. Click Modify in the VSIX Installer dialog box to start the installation.
4. Click Close when the installation is completed.

You can execute MFVSIXInstall.exe from the command line with different parameters. For example, to
uninstall Enterprise Developer from all editions of Visual Studio, execute MFVSIXInstall -u.

For a list of all parameters execute MFVSIXInstall -?.

On UNIX
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Installing as an Upgrade
This release works concurrently with the previous version of Micro Focus Enterprise Developer Unix
Components, so you do not need to uninstall it.

Install the latest version in a different location and set the environment to point to it. To do this, run the
Micro Focus Enterprise Developer Unix Components installer with the –installlocation option:

1. Execute the following command:

./InstallFile -installlocation="/opt/microfocus/EnterpriseDeveloper"

Note: You can use variables when specifying an absolute path for –installlocation. For
example, the following examples are equivalent:

-installlocation="/home/myid/installdir"

-installlocation="$HOME/installdir"

2. Execute cobsetenv to set the environment and point to the new install location:

. /opt/microfocus/EnterpriseDeveloper/cobsetenv

Note: cobsetenv is only compatible with POSIX-like shells, such as bash, ksh, or XPG4 sh. It is
not compatible with C-shell or pre-XPG4 Bourne shell.

Micro Focus Enterprise Developer Unix Components Installation
Options

Installing into a different location

To install in a different location use the -installlocation="Location" parameter to specify an
alternative directory location. For example:

./setup_entdev_3.0_platform -installlocation="full path of new location"

Note: You can use variables when specifying an absolute path for –installlocation. For
example, the following examples are equivalent:

-installlocation="/home/myid/installdir"

-installlocation="$HOME/installdir"

You can see details about which additional parameters can be passed to the install script if you enter the -
help option.

Configuring the Enterprise Server installation

You can use the following options to configure the Enterprise Server installation: [ -
ESsysLog="location" ] [ -ESadminID="User ID" ] [ -CASrtDir="location" ], where:

-ESsysLog Specifies a location in which the build will create the Enterprise Server System log file - for
example, -ESsysLog="/home/esuser/logs". The default location is /var/mfcobol/
logs.

-ESadminID Sets the Enterprise Server System Administrator Process User ID from the command line -
for example, -ESadminID="esadm". The default user ID is the one that runs the installer.

-CASrtDir Specifies the location were the Enterprise Server run-time system files are placed - for
example, -CASrtDir="/home/esuser/casrt/es". The default location is /var/
mfcobol/es.
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Installing Silently

You can install Micro Focus products silently by using command line parameters to specify the installation
directory, user information, and which features to install. You must execute the command with superuser
permissions.

You can use the following command line arguments to install silently on UNIX/Linux:

–silent -IacceptEULA

For example, execute:

[as root] setup_filename –silent -IacceptEULA

After Installing
• See Changes in Behavior or Usage in your product documentation and in the Release Notes for

important information about changes in this release that might affect existing applications.
• Check the Product Documentation section of the Micro Focus SupportLine Web site and the Micro

Focus Infocenter for any updates to the documentation which might have been uploaded.

On Windows

Starting the Product
You are now ready to run Enterprise Developer:

Windows 7 and
Earlier

• From your desktop, click Start > All Programs > Micro Focus Enterprise
Developer > Enterprise Developer for Visual Studio 2012.

• From your desktop, click Start > Visual Studio 2017.

Windows 8, 8.1, and
Windows Server 2012

• From the Start screen, click the Enterprise Developer for Visual Studio
2012 tile.

• Click the Visual Studio 2017 tile.

Windows 10 and Later • Click Start > Micro Focus Enterprise Developer > Enterprise Developer
for Visual Studio 2012.

• Click Start > Visual Studio 2017.

Viewing the Product Help
To view the documentation installed with your product:

1. Start Visual Studio.
2. Ensure that the Visual Studio Help Library is pointing to local help - from the Visual Studio menu click

Help > Set Help Preferences > Launch in Help Browser.
3. Click Help > View Help.

This opens the product help in Microsoft's Help Viewer.

For full details of the Visual Studio Help system, see the MSDN.

If, after Enterprise Developer was installed, you do not see its product help in the Help Viewer, you need to
install the documentation manually as follows:

1. In Visual Studio 2017, ensure the Visual Studio Help Viewer is installed.

See Installing missing components of Visual Studio 2017 in Software Requirements for instructions on
how to install it.
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2. Start Visual Studio.
3. Click Help > Add and Remove Content.

This starts the Microsoft Help Viewer.
4. Click the Manage Content tab and click Disk.
5. Click the browse button next to Disk and navigate to the %ProgramFiles(x86)%\Micro Focus

\Enterprise Developer\Help folder.
6. Select helpcontentsetup.msha and click Open.

This loads the Enterprise Developer documentation.
7. Click Add and then Update.

After the installation is complete, the Enterprise Developer product Help appears in the Help Viewer.

Note: On some Windows versions such as Windows 8 or Windows Server 2012, an issue with
Microsoft Help Viewer and Internet Explorer's security being turned on can cause the Help content to
be displayed as raw HTML code. To resolve the issue, you need to turn off the Internet Explorer
Enhanced Security Configuration (IE ESC) for both administrators and users. Check the Microsoft
Windows help for more information on how to do this.

Repairing
If any product files, registry settings or shortcuts are accidentally removed at any point, you can perform a
repair on the installation to replace them.

To repair your installation on versions of Windows Vista or later:

1. From the Control Panel, click Uninstall a program under Programs.
2. Right-click your Micro Focus product and select Repair.

Uninstalling
To uninstall the product, you cannot simply delete its files from your hard disk. To uninstall the product:

1. Log in with the same user-ID as you used when you installed the product.
2. Click Uninstall a program under Programs in Control Panel.
3. Select the product and click Remove or Uninstall as appropriate.

When you uninstall, the only files deleted are those that the installation software installed. If the product
directory has not been removed, delete any unwanted files and subdirectories within it using Windows
Explorer.

Note: The installer creates separate installations for Micro Focus Enterprise Developer, Enterprise
Server for .NET, and Micro Focus License Administration. Uninstalling only Enterprise Developer
does not automatically uninstall Enterprise Server for .NET, the Micro Focus License Administration
or any of the prerequisite software.

Enterprise Server for .NET must be uninstalled before you remove Enterprise Developer. To
completely remove the product you must uninstall the Micro Focus License Administration as well.

You can optionally remove the prerequisite software. For instructions, check the documentation of the
respective software vendor.

Some registry entries are not removed by the uninstallation process and you need to manually delete
them.

The following folders might not be removed:

• The Micro Focus Product Name folder in the Start menu - you can delete it manually.
• %systemdrive%\Users\Public\Documents\Micro Focus - includes the binaries and the log

files of the samples which you have built.
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• %ProgramData%\Micro Focus - includes some data files used by the Micro Focus licensing system.
• %Program Files%\Micro Focus - you can delete it manually.

To silently uninstall the product, you need the setup file and you need to execute the following at the
command line:

start /wait install-file.exe /quiet /uninstall

In addition, the following registry entries are not removed. These are created the first time that an
Enterprise Server that has been enabled for performance monitoring starts up:

• Micro Focus Server\Performance\Active Servers
• Micro Focus Server\Performance\PerfIniFile

On UNIX

Repairing on UNIX
If a file in the installation of the product becomes corrupt, or is missing, we recommend that you reinstall
the product.

Uninstalling
Note: Before you uninstall the product, ensure that the Enterprise Server instances and the Micro
Focus Directory Service (MFDS) are stopped.

To uninstall this product:

1. Execute as root the Uninstall_EnterpriseDeveloper3.0.sh script in the $COBDIR/bin
directory.

Note: The installer creates separate installations for the product and for Micro Focus License
Administration. Uninstalling the product does not automatically uninstall the Micro Focus License
Administration or the prerequisite software. To completely remove the product you must uninstall the
Micro Focus License Administration as well.

To uninstall Micro Focus License Administration:

1. Execute as root the UnInstallMFLicenseServer.sh script in the /var/
microfocuslicensing/bin directory.

The script does not remove some of the files as they contain certain system settings or licenses.

You can optionally remove the prerequisite software. For instructions, check the documentation of the
respective software vendor.
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Licensing Information
Note:

• If you have purchased licenses for a previous release of this product, those licenses will also
enable you to use this release.

• If you are unsure of what your license entitlement is or if you wish to purchase additional licenses,
contact your sales representative or Micro Focus SupportLine.

To start Micro Focus License Administration

Windows 7 and Earlier • From your desktop, click Start > All Programs > Micro Focus
License Manager > License Administration

Windows 8, 8.1, and
Windows Server 2012

• From the Start screen, click the License Administration tile

Windows 10 and Later • Click Start > Micro Focus License Manager > License
Administration

Installing licenses
You need either a license file (with a .mflic extension) or an authorisation code which consists of a 16-
digit string of letters and numbers.

If you have a license file

1. Start Micro Focus License Administration.
2. Click the Install tab.
3. Do one of the following:

• Click Browse next to the License file field and select the license file (which has an extension
of .mflic).

• Drag and drop the license file from Windows Explorer to the License file field.
• Open the license file in a text editor, such as Notepad, then copy and paste the contents of the file

into the box below the License file field.
4. Click Install Licenses.

Alternatively, you can install the license file from within the IDE as follows:

1. Start Enterprise Developer.
2. Click Help > Micro Focus Product Help > Product Licensing to open the Product Licensing dialog

box.
3. Ensure I have a full Enterprise Developer Team Edition license is checked.
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4. Click Browse next to the License file field.
5. Select the license file (which has an extension of .mflic), and then click Open.
6. Click Authorize to install the license.

You should see a dialog box with a confirmation that the licenses have been installed successfully.

If you have an authorization code

Authorizing your product when you have an Internet connection
Note:

• It is not possible to install licenses remotely. You must be logged into the machine on which you
are installing the licenses.

The following procedure describes how to authorize your product using a local or network license server.
The license server is set up automatically when you first install the product.

1. Start Micro Focus License Administration.
2. Click the Install tab.
3. Type the authorization code in the Enter authorization code field.
4. Click Authorize.

If you change the name of the machine running your license server after it has granted licenses, the
licenses stop working.

Authorizing your product when you don't have an Internet connection
This method of authorization is required if the machine you want to license does not have an Internet
connection or if normal (automatic) authorization fails.

1. Start Micro Focus License Administration.
2. Click Manual Authorization on the Install page.
3. Make a note of the contents of the Machine ID field. You will need this later.
4. Do one of the following:

• If your machine has an Internet connection, click the SupportLine Web link in the Manual
Authorization Information window.

• If your machine does not have an Internet connection, make a note of the Web address and type it
into a Web browser on a machine that has an Internet connection.

The Micro Focus SupportLine Manual product authorization Web page is displayed.
5. Type the authorization code in the Authorization Code field. The authorization code is a 16-character

alphanumeric string supplied when you purchased your product.
6. Type the Machine ID in the Machine ID field.
7. Type your email address in the Email Address field.
8. Click Generate.
9. Copy the generated license string (or copy it from the email) and paste it into the box under the License

file field on the Install page.
10.Click Install Licenses.
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To obtain more licenses
If you are unsure of what your license entitlement is or if you wish to purchase additional licenses for
Enterprise Developer, contact your sales representative or Micro Focus SupportLine.
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Updates and SupportLine
Our Web site gives up-to-date details of contact numbers and addresses.

Further Information and Product Support
Additional technical information or advice is available from several sources.

The product support pages contain a considerable amount of additional information, such as:

• The Product Updates section of the Micro Focus SupportLine Web site, where you can download fixes
and documentation updates.

• The Examples and Utilities section of the Micro Focus SupportLine Web site, including demos and
additional product documentation.

• The Support Resources section of the Micro Focus SupportLine Web site, that includes troubleshooting
guides and information about how to raise an incident.

To connect, enter http://www.microfocus.com in your browser to go to the Micro Focus home page, then
click Support & Services > Product Support. In the Browse by Product field, click the product you
require support for. Click Log into SupportLine.

Note: Some information may be available only to customers who have maintenance agreements.

If you obtained this product directly from Micro Focus, contact us as described on the Micro Focus Web
site, www.microfocus.com. If you obtained the product from another source, such as an authorized
distributor, contact them for help first. If they are unable to help, contact us.

Also, visit:

• The Micro Focus Community Web site, where you can browse the Knowledge Base, read articles and
blogs, find demonstration programs and examples, and discuss this product with other users and Micro
Focus specialists. See http://community.microfocus.com.

• The Micro Focus YouTube channel for videos related to your product - see https://www.youtube.com/
user/MicroFocusIntl.

Information We Need
However you contact us, please try to include the information below, if you have it. The more information
you can give, the better Micro Focus SupportLine can help you. But if you don't know all the answers, or
you think some are irrelevant to your problem, please give whatever information you have.

• The name and version number of all products that you think might be causing a problem.
• Your computer make and model.
• Your operating system version number and details of any networking software you are using.
• The amount of memory in your computer.
• The relevant page reference or section in the documentation.
• Your serial number. To find out these numbers, look in the subject line and body of your Electronic

Product Delivery Notice email that you received from Micro Focus.

On Windows, if you are reporting a protection violation you might be asked to provide a dump ( .dmp) file.
To produce a dump file you use the Unexpected Error dialog box that is displayed when a protection
violation occurs. Unless requested by Micro Focus SupportLine, leave the dump setting as Normal

Updates and SupportLine | 79

http://www.microfocus.com
http://community.microfocus.com
https://www.youtube.com/user/MicroFocusIntl
https://www.youtube.com/user/MicroFocusIntl


(recommended), click Dump, then specify a location and name for the dump file. Once the dump file has
been written you can email it to Micro Focus SupportLine.

Alternatively, you might be asked to provide a log file created by the Consolidated Tracing Facility (CTF) - a
tracing infrastructure that enables you to quickly and easily produce diagnostic information detailing the
operation of a number of Micro Focus software components.

On Windows, you can use the Micro Focus SupportLine Support Scan Utility, MFSupportInfo, to create
either:

• a .log file that contains the details about your environment, Micro Focus SupportLine products, and
settings.

• a .zip archive that includes the same information as the .log file plus some product configuration
files from c:\ProgramData and the product installation log files.

MFSupportInfo.exe is stored in <install-dir>\bin.

To run MFSupportInfo:

1. Start a 32-bit Enterprise Developer command prompt.
2. Enter MFSupportinfo at the command prompt to start the utility.
3. Create a .log file or a .zip archive as follows:

a. To create a .log file, click File > Save.

This prompts to save the .log file, MFSupportInfo_Log_MachineName_YYYY-MM-DD_HH-MM-
SS.log, in the %temp% directory.

b. To create a .zip archive, click Tools > Create Zip Package.

This creates a .zip archive, MFSupportInfo_Log_MachineName_YYYY-MM-DD_HH-MM-
SS.zip, in the %temp% directory.

4. Send the diagnostic information to your Micro Focus SupportLine representative:

The following requires an Internet connection and an Email client:

a. Click Tools > Email Log to SupportLine to open the Email Log dialog box.
b. Fill in the required fields and click Send.

If the machine is not connected to the Internet or if there are no Email clients installed, copy either
the .log file or the .zip archive to a machine that is connected to the Internet. Use your Email client
to email the files to Micro Focus SupportLine at supportline@microfocus.com together with the Support
Incident (SI) number, if available, and any additional details that might be useful to diagnose the issues
that you are experiencing.

Creating Debug Files
If you encounter an error when compiling a program that requires you to contact Micro Focus SupportLine,
your support representative might request that you provide additional debug files (as well as source and
data files) to help us determine the cause of the problem. If so, they will advise you how to create them.
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Copyright and Disclaimer
Copyright © Micro Focus 2017. All rights reserved.

The only warranties for this product and any associated updates or services are those that may be
described in express warranty statements accompanying the product or in an applicable license agreement
you have entered into. Nothing in this document should be construed as creating any warranty for a
product, updates, or services. The information contained in this document is subject to change without
notice and is provided "AS IS" without any express or implied warranties or conditions. Micro Focus shall
not be liable for any technical or other errors or omissions in this document. Please see the product's
applicable end user license agreement for details regarding the license terms and conditions, warranties,
and limitations of liability.

Any links to third-party websites take you outside Micro Focus websites, and Micro Focus has no control
over and is not responsible for information on third party sites.
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